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1. Introduction 
 

In this chapter you can find the overview of TaxWorkFlow and to understand the structure of it. TaxWorkFlow 
functionality and future development are also described in this chapter. 
 
 
Overview 
 
TaxWorkFlow is a comprehensive practice management solution for tax professionals that simplifies the tax 
preparation process while ensuring optimal organization of client data, efficient internal and external communication, 
and successful tax return completion. But it goes far beyond tax preparation! 
 
TaxWorkFlow also has comprehensive Client Relationship Management (CRM) capabilities allowing firms to 
consolidate contact information, tax data and documents, and account activity for each client. You can even track 
client referrals within the database and, if you choose, offer clients discounts based on this activity. 
 
Workflow functionality is the backbone of TaxWorkFlow’s streamlined Workflow Management System. The work for 
each client is organized as a series of tasks that can be customized at the universal or individual customer level. That 
way, you can reproduce success each time for each customer. TaxWorkFlow also allows you to manage multiple 
accounts, i.e. business and individual returns, and raise alerts in case some conditions fail or materialize, ensuring 
that a comprehensive tax return is completed on time for every client -- automatically. 
 
TaxWorkFlow contains a powerful Document Management System. You may store all important business 
documents directly in the database instead of a local computer. For your convenience, all documents can be 
categorized according to your preferences. You may create as many folders and subfolders as you wish and upload 
all types of documents to the system using corresponding buttons or simply by drag-and-drop file migration. If 
uploaded files are too large, the file can be uploaded in the background using the drag-and-drop feature. You can also 
automatically pick up, categorize and file the documents under individual clients with a separate service program. 
 
TaxWorkFlow offers administrators and managers the ability to assign individual user passwords and logins to control 
access to information and to monitor workflow progress, so you always know who is responsible for what, how much 
progress has been made, and when the tasks at hand have been completed.  
 
TaxWorkFlow can also serve as a convenient client-facing tax portal residing on the website of tax professionals 
enabling appointment scheduling, document exchange, and communications management to be executed 
seamlessly. Delivering documents to customers electronically and/or having  clients upload their documents directly 
into your centralized storage database saves you time and money. Uploaded documents will be filed under specific 
categories under the corresponding customer. 
 
The Structure of TaxWorkFlow  
 
TaxWorkFlow is a unique software application that combines the processing speed and application integration of a 
PC desktop platform with the enhanced offsite data storage capacity and collaboration of a cloud-based solution. 
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Using a native Windows application provides you with the following productivity enhancers unlike other Web 
applications: 
 Native controls that are much more productive than other workflow systems. For example, you can use key 

shortcuts to do quick jobs, or simply navigate faster using the TAB, SPACE, ENTER, or arrow keys across 
navigation controls. This means you have both hands on the keyboard at all times, increasing your typing and 
work processing speed. If you are tired of struggling with your mouse all day long, TaxWorkFlow is the solution 
for you! 

 You can have multiple windows open that will automatically refresh when changes are made in another window. 
With browsers, you are forced to manually refresh the windows and wait for the result to show on screen. And 
how many times you had to redo your work due to an outdated browser session? That never happens with 
TaxWorkFlow. 

 TaxWorkFlow saves you between two and five seconds each time you switch between screens compared to a 
browser-based solution because only data is downloaded from the cloud, not the whole page. As a result, the 
software’s responsiveness is unbeatable. 

 You can use the drag-and-drop feature to seamlessly drag files and emails into the document storage. No need 
to use cumbersome upload buttons and file dialogs. This will save you hours during tax season! 

 
Windows Shell and Web Integration 
 
TaxWorkFlow can be used to create links that open just like you would open an URL, so you can send links to the 
documents saved in the database, just like you would do with web links! 
 
For example, when you invite somebody to the system, he or she will get the e-mail with two links: 
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First link allows new user to download the installer. After the installation is finished user will click the activation link 
from the message and from this moment he or she can work with TaxWorkFlow. 
 
Links in e-mails are very useful and will save you a lot of time. In each task or project e-mail notification you can find 
the link, click on it and open the certain task or project. If some document was published and you've got a notification 
about it you can open this document immediately. Click the link from the message and the document will be opened, 
so you don't need to open an application and search for the certain document. 
 
TaxWorkFlow Functionality 
 
TaxWorkFlow incorporates many powerful capabilities allowing every step of the tax preparation process to be 
managed and completed effortlessly, efficiently, and correctly. Here is a sample list of goals you can achieve by using 
TaxWorkFlow. 
 Schedule the types of work you do and who will be doing them in what sequence 
 Organize hundreds of tasks to be completed by various team players, such as admin work, tax preparation, 

accounting, invoicing, and outsourcing functions  
 Add new staff users by sending simple invites containing all instructions they need to get up and running fast 

inside your workflow 
 Fine-tune staff user access depending on permissions for security and integrity purposes 
 Schedule default processors for certain events to better organize your staff's time and productivity 
 Delegate routine task management or problem detection to an interactive system that acts according to 

comprehensive and flexible workflow rules 
 Keep track of all your clients information, and every aspect of your communication with them, including tax 

related information, preferences, actual email messages and notes, input documents, tasks, events, meetings, 
reminders, referrals, project notes and deliverables 

 Organize all your documents electronically in the cloud by category, customer, and work completed. Plus, you 
can quickly find what you need later based on the various criteria 

 Use drag-n-drop and automated pick up / filing system to save time instead of loading large amounts of paper 
into the system, or even have your customers securely upload the input into your online storage  

 Import/export documents and burn them to DVDs directly from the application  
 Share customer documents and emails with your team working on the project, ensuring everybody is in the loop 
 Publish draft returns and other customized categories to customers automatically 
 Perform bulk email and mail campaigns to notify your clients about various events and deadlines 
 Reassign tasks as your workload and resources change over time  
 Monitor your staff time, productivity, progress reports, and adjust priorities on the fly 
 Track missing information for each customer's return, either individually or based on a global template rules  
 Save your time by having automated reminders emailed to customers if there is information needed to keep 

moving forward on the tax return 
 Ensure special tax return requirements are met for some of your clients -- automatically and on time 
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Future Development 
 
We have scheduled many enhancements for the future releases of the TaxWorkFlow system, including but not limited 
to: 
 Calendar, web site, and full email integration 
 Integration of invoices to QuickBooks 
 Posting invoices and accepting payments from clients on the website via a variety of merchant interfaces 

 
 
 

2. Configuration Management 
 

This chapter describes the installation process. Here you can find out how to accept and send invitations and how to 
change connections. You'll learn how to set your company's profile. User management and user activity are also 
described here. 
 
 
Installation of the Software 
 
Installation of TaxWorkFlow is simple. Just download the setup file provided to you and run the program.  
 
You can always find the latest installer at this web address: 
 
http://www.thetaxworkflow.com/release/TaxWorkFlowSetup.exe 
 
After launching the installer, you will see the standard windows setup wizard as shown below. 
 

 

 
You need read and accept the license agreement to continue with the installation of the software: 
 

http://www.thetaxworkflow.com/release/TaxWorkFlowSetup.exe
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Now choose the directory where you want to install the software: 
 

 
 
Select the Start Menu folder to create program's shortcuts: 
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Check the checkbox if you wish to create a TaxWorkFlow desktop icon: 
 

 
 
Review the chosen options before beginning the installation process: 
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Now the installation will begin.  
 

 
 
During this process, you will be offered to install Microsoft Visual C++ 2010 components if you don't have them 
installed on your PC. Click "Install" and continue the installation process. 
 
Also the PDF printer driver will be installed to your system. 
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Press "Next" to install the driver. 
 

 
 
Press "Finish" to close PDF printer driver installation wizard: 
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Finally, the setup process will warn you about Windows Firewall changes. It's a necessary procedure to enable 
connections to the cloud database. 
 

 
 
To read a firewall setup guide please follow an appropriate link below: 
Comodo Internet Security 
ESET NOD32 Antivirus 
Kaspersky Internet Security 
McAfee Internet Security 
PC Tools Internet Security 
Symantec Norton Internet Security 
ZoneAlarm Free Firewall 
 
The TaxWorkFlow installation is completed. 
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Tip: "Please run TaxWorkFlowSetup.exe as an administrator If the installation process was 
interrupted by the system on any step." 
 
You will need to configure at least one connection in order to work with the system. You can learn how to do it in the 
next sections of this guide. If you already had a connection to the system before (as part of our beta-testing program), 
you will see your previous connections when you run the program and you will be able to connect to them. 
 
Comodo Internet Security 
 
1. Open your firewall’s main window. 

 

2. Select “Advanced View” mode. 
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3. Click the “Firewall” link. 
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4. Select “Firewall –> Application Rules” tab and click “Add” button. 

 

5. Select “Files” from the “Browse” drop-down list and browse to TaxWorkFlow.exe. 
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6. Check “Use a Custom Ruleset” and select “Allowed Application” ruleset from the “Copy from” drop-down list. 
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7. Check your created rule in the list of rules and click OK. 

 

8. Check your created rule in the list of rules and click OK again. 
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9. Repeat steps from 5 to 8 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter 

subfolder of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
ESET NOD32 Antivirus 
 
1. Open your firewall’s main window. 
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2. Select “Setup” tab and click “Enter advanced setup” link. 

 

3. Select “Web and email -> Protocol filtering -> Excluded applications”, click “Add” button and browse to 

TaxWorkFlow.exe. 
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4. Click OK. 

 

5. Repeat steps from 3 to 4 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter 

subfolder of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
Kaspersky Internet Security 
 
1. Open your firewall’s main window. 
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2. Click on the “Application Control” section. 

 

3. Click “Manage applications” link. 
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4. Find TaxworkFlow.exe in the list and double click on it. 

 

5. Select “Network rules” tab and select “Allow” for each network activity in the list. 
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6. Repeat steps from 4 to 5 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter 

subfolder of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
McAfee Internet Security 
 
1. Open your firewall’s main window. 

 

2. Select “View firewall and anti-spam settings” in “Web and Email Protection section”. 
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3. Click the “Firewall” link. 

 



27 

 

4. Select “Internet Connections for Programs”. 

 

5. Click “Add” button. 
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6. Click “Browse” button and browse to TaxWorkFlow.exe. 
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7. Make sure that “Access” is set to full and “Net Guard” is off and click the “Save” button. 

 

8. Repeat steps from 5 to 7 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter subfolder 

of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
PC Tools Internet Security 
 
1. Open your firewall’s main window. 
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2. Select “Settings” tab. 

 

3. Select “Firewall -> Applications”, click “Add” button and browse to TaxWorkFlow.exe. 
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4. Click on the  icon in the “In” column and select “Allow All”. 
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5. Repeat steps from 3 to 4 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter subfolder 

of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
Symantec Norton Internet Security 
 
1. Open your firewall’s main window. 

 

2. Select “Settings”. 

 

3. Select “Network” tab. 
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4. Select “Smart Firewall” section. 

 

5. Click “Configure” link under the “Program Rules”. 
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6. Click “Add” button and browse to TaxWorkFlow.exe. 

 

7. Select “Allow always” from the “Options” drop-down list and click OK. 
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8. Click Apply and OK. 
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9. Repeat steps from 6 to 8 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter subfolder 

of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
ZoneAlarm Free Firewall 
 
1. Open your firewall’s main window. 
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2. Click “View Details” in “Firewall” section. 

 

3. Click “# programs secured” link under the “Application Control” section. 

 

4. Select “View Programs” tab. Click “Add” button and browse to TaxWorkFlow.exe if it isn’t already in the list. 
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5. Change “Trust Level” on “Super” or “Trusted” for TaxWorkFlow.exe. 
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6. Select “Allow” in all other columns for TaxWorkFlow.exe. 

 

7. Repeat steps from 4 to 6 again for the TWFPDFPrinter.exe file. It should be located in the TWFPDFPrinter subfolder 

of the application’s folder (by default it is usually C:\Program Files 

(x86)\TaxWorkFlow\TWFPDFPrinter\TWFPDFPrinter.exe). 

 
Accepting invitations 
 
When you create a corporate account with us, we will send an invitation to your administrator containing your account 
parameters, such as web address, database login and password, and other configuration details via an email. Your 
administrator will be able to accept the invitation either by clicking on the email link, or pasting the invitation code into 
the application. The email invitation will look like this: 
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If the link is not active (for example, you are viewing it from a Google or Hotmail account in your browser), you can 
copy the entire coded string containing the invitation from the message to clipboard: 
 

 
 
Then launch TaxWorkFlow and go to the “File>Accept invitation” main menu item. The following form will be 
displayed. 
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Paste the previously saved string into this dialog and click the “Accept” button. After that the connection will be added 
to the connections list. When you add your first connection, it’ll be set as a default connection and established 
automatically after you accept the invitation. Adding subsequent connections they’ll be added to the connections list 
and you’ll be offered to re-connect to another database using a new connection. 
 
If you are the administrator, you can then create other users and invite them the same way so that users can establish 
this connection on their home or office workstations. Please see Sending invitations section for more information 
about this. 
 
How to select connection 
 
After you accept the invitation sent to either by us or by your administrator, you will be ready to work with 
TaxWorkFlow. If you have more than one subscription, a number of companies and offices then you need to know 
how to select a connection. Please note, if you have just one subscription, the information in this topic is useless for 
you.  
 
In order to establish the connection to another database, go to the “File->Select connection” menu item or "File-
>Connect to...".  
 
You will be prompted to select a connection: 
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Choose the connection from the list and click the “Select” button. If the selected connection was configured properly 
your connection to the database will be established.  
 
Also from here you can modify a connection, set a default connection, import and export connections. 
 
Please note that you can have multiple accounts if your system runs several independent practices, for example the 
office account, and your private clients who you work with exclusively. In this case, you can switch between accounts 
on the fly using this dialog. 
 
To avoid switching during application start-up, you can place an icon on your desktop specifying the connection you 
would like to establish on this icon, overriding the default connection. This option could be useful if you prefer to start 
the desired connections from the icon on the desktop when you work with many connections at the same time.  
 
Let’s look at an example. Suppose you have a default Office connection and you want to create a desktop icon for the 
“Private Clients”. The first step will be to create icons on the desktop, and then go to the properties of each of them as 
shown in the picture below. 
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Next, add the Connection="Private Clients” string to the target field in the properties window as shown below. Here, 
the "Private Clients” is the exact name of your connection. Use quotes if the connection name consists of several 
words separated by spaces. 
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After you apply these settings you may use this icon to launch TaxWorkFlow with the "Private Clients” connection 
regardless of which connection was set up as the default earlier.  
 
 
 
 
How to edit connection 
 
To manage the connection, or add, remove, or edit other connections, select the  
“File>Edit connections” menu item.  
 
You will see the “Edit connections” form: 
 

 
 
From here you are able to add, modify, duplicate, or delete connections, to set the selected connection as the default 
and to import or export connections. The default connection is established automatically when you launch the 
application. This gives you the opportunity to start with the most commonly used database.  
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In regard to importing and exporting connections, if you were a TaxWorkFlow beta tester, you received an INI-file 
containing connection settings that you can import  into the system using the “Import” button from the form above. 
Click it, then choose the INI-file, enter the connection name and you will see it in the list of existing connections.  
 
If you wish to work with the program from more than one computer, you may export your connections to a REG-file. 
Click the “Export connection to REG-file” button to export the selected connection or the “Export all” button to export 
all existing connections. Once you’ve exported connections you can copy the resulting REG-file to another computer 
and run it in a Windows environment by double-clicking on it from Windows Explorer. This should write connection 
settings to the registry and you will be able to see them in the connection list when you launch the program on your 
other computer. You can also send an invite to yourself to make it easier. 
 
To add or modify connections, click the “Add” or “Modify” buttons you will see on the following form: 
 

 
 
First, specify a unique connection name. You will not be able to save settings if the “Connection name” field is empty. 
There are seven tabs in this form containing different settings. On the “Current user” tab you may set your preferred 
settings for the TaxWorkFlow application that will apply only to this particular installation. It contains following fields: 

• “Domain Authentication”. This feature is used by large organizations that have their own domain in their office. It 
provides additional security and user management benefits. Most smaller office users will not have this installed 
in their firm. Please contact us at support@thetaxworkflow.com if you wish to have the domain integration 
enabled. 

• “Authentication mode” options provide you with extra security when many other people have access to your 
account on your computer (i.e. there is no login password on your workstation). You can select one of three 
modes from the list: 

• 1) “Save login and password” where both the login and password will be stored in the system registry in the 
encrypted form. This is the default option and that allows you to immediately establish the connection to the 
account from saved account credentials.  

• 2) “Save login only” saves only the encrypted in the system registry, so the system will prompt you for password 
when you launch the application.  

• 3) “Always prompt for login/password” makes you always enter both login and password manually at application 
startup.  
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• “Encrypted login” – encrypted user login. Click the magnifying glass icon to decrypt in order to see your current 
values, or click the pencil icon to modify it. 

• “Encrypted password” – encrypted user password. Click the magnifying glass icon to decrypt it or the pencil 
icon to modify it. 

• “Test user credentials” allows you to check if all user settings are correct and the connection works properly. 
  
On the “Database” tab you may set the database connection settings: 
 

 
 
 
All of these settings will be available to you when you create an account with us via the previously described invitation.  
 
You will most likely never modify these fields unless you are moving to another account or server. This form contains 
following fields: 

• “Encrypted database address” – encrypted internet address of database in the cloud  
• “Encrypted catalogue” – encrypted path to your database name  
• “Encrypted db login” – encrypted database user’s login 
• “Encrypted db password” – encrypted database user’s password 
• “Database driver” – select “Microsoft SQL Server” or “MySql” database driver from the list. It may be needed to 

manually install the driver if you choose it after the installation of the TaxWorkFlow application. 
• “Test database connection” allows you to verify if all database settings are correct and the connection is 

available. 
 
On the "Outgoing Email" tab you may set existing email account settings to use for outgoing email notifications (for 
example, in email campaigns or reminders). 
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The form contains the following fields: 

• “From email address” – specify your email address here 
• “SMTP server IP or name” – specify the IP address or domain name of the server your email account is 

registered at 
• “SMTP server port” – depends on your POP and SMTP server’s settings (it is not recommended to use 25 port 

for the SMTP server, as it provides no encryption of the outgoing emails and can be subject to identity theft) 
• "Connection security" - depends on your SMTP server’s settings (SSL/TLS is recommended) 
• “Authentication method” – depends on your server’s settings 
• “Authentication login” – encrypted user login to the SMTP server. Click the magnifying glass icon to decrypt it or 

the pencil icon to modify it 
• “Authentication password” – encrypted user password to the SMTP server. Click the magnifying glass icon to 

decrypt it or the pencil icon to modify it 
 
If you are using a common post servers such as Gmail, AOL, etc. you can find the values to put in the fields listed 
above on your post server’s settings pages. Please refer to your email provider for these settings, or email us for help 
setting up your account if you experience issues with a certain mailbox. 
 
For example, here are the sample settings for a GMAIL email account: 
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To make sure everything works press “Send test email” button, enter an email where you want to send a test 
message, press “OK” and check the email for test message. Check "Email sync troubleshooting" topic if you have 
some issues setting up email. 
 
The next tab is “Usability” tab: 
 

 
 

• “Style” – select a style you prefer from the list. You may wish to select the style that gives you the best visual 
delivery so you can work more productively. 

• “Always confirm on exit” – the system will always ask you for confirmation before quitting the application. 



49 

 

• “Maximize windows” – all TaxWorkFlow windows opened will be maximized automatically. This helps optimize 
the usage of your screen. 

• "Automatically launch dashboard at application startup" - Dashboard starts automatically by default. You can 
find more information about it in Dashboard chapter of this guide. 

• "Automatically save layout" - save the layout for the chosen connection automatically. 
 

“Updates” tab contains only one field: “Update server name”. Enter “thetaxworkflow.com” value here to allow the 
system to be updated from the original TaxWorkFlow server if newer releases are available. 
 

 
 
"QR Code" tab contains the QR code that can be scanned from your TaxWorkFlow iOS or Android application. This 
code allows you to connect to your database from the mobile application. 
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"File Associations" tab allows you to select what file types you would like to open by external applications when you 
open them from TaxWorkFlow. By default all these file types are opened inside TaxWorkFlow but you can change 
these settings in this tab and open some file types by your default Windows program: 
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Office settings 
 
The office settings are system-wide settings affecting the behavior of the application for all users and computers, and 
includes templates, company information, security policy, and other rules. Only administrators can modify them. 
 
To view or edit your office settings you need to select “Administration”>”Office settings…”.  
 
The "Policies" tab allows you to select an authentication mode and synced email permissions: 
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The "Office Information" tab allows you to fill out your office’s information.  
 

 
 
You can add another office if you are doing business and bill your client under several names. In this case, you can 
assign individual offices to your client records. This relationship will be used in email templates and invoicing.  
 
To edit an existing office click a “Edit office” button or open it with left mouse button double-click. To add a new office 
click "Add new office" button. If you need to delete office click "Delete Office" button and "Office deletion wizard" will 
help you unlink the deleted office from tasks, projects, clients 
 
The "Return Types" tab allows you to manage the return types your office services. These values are used in a great 
number of dialogs, such as client information, tasks, projects, and problems. In this tab, you can add a return type, 
modify existing types or delete them. 
 



53 

 

You can block users from entering arbitrary Return Type values by checking the box "Allow only these serviced return 
type values in client records". This will make sure that only return types will be tracked that are serviced by your office, 
providing consistent view of the client records. 
 
You can also use "Make return type values optional in client records" to allow users to skip entering return types in 
case it's not applicable to certain clients. 
 

 
 
"Services Provided" tab allows you to manage services provided by your office. 
 

 
 
The "Email Templates" allows you to edit and save templates for your emails. There are built-in email templates used 
in automated notifications, such as Invitations, Reminders or Problems. You can customize them with your logo, 
contact information, etc. 
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You can also add your own email templates here by clicking "Add a new user template" button or you can duplicate 
and customize an existing template for a specific office by clicking "Duplicate Email Template" button. 
 
For example, below is a template of account activation instructions. When you invite some user to TaxWorkFlow this 
template will be sent with your and user's details. 
 

 
 
The following templates are also pre-built in TaxWorkFlow: 
 

Template Usage 

Client Email Template Email to a client 

Client Portal Document Upload Email 
Template 

Notification of new documents uploaded by the client to the Portal 

Document Attachment Email Template Send documents as attachments to your clients 

Document Publication Email Template Send email notifications to clients when new documents are published to the Tax    
asking the clients to review and get back with any comments 

Invoice Attachment Email Template Send the invoice as a PDF or XLS attachment to client for payment 

Password Reminder Email Template Send an email with the password reminder or a new password, either manually f    
automatically when the client requests the password when logging in to the client      

Problem Email Template Sending the list of unsolved problems to the client as an email reminder to follow     
problems, i.e. missing documents, unpaid invoice, etc. 

Project Creation Email Template Notification on new project creation 

Project Task Completion Email Template Notification on project task completion 

Referral Thank You Email Template Thank you message to the client who referred you client(s) 

Reminder email template Remind client about previously sent email (i.e. missing documents or unpaid invo      
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Template Usage 

yet 

System message template Automatically compiled message regarding task/project completion and other use   
 
Also, you can select from what email address each email template should be sent. The list of emails is available at 
"Send from:" field. To manage this list you need to open "Outgoing Email Accounts" tab. 
 
"Invoice Templates" contains the list of available invoice templates. There is one system template. Also you can 
create your own templates using Excel-like functionality that allows you to customize template according your needs. 
"Duplicate Invoice Template" button allows you to duplicate the template for another office of your company: 
 

 
 
Please use the list of macros from Appendix B to create/edit invoice templates. 
 
"Outgoing Email Accounts" tab is a place where you can manage your global outgoing email accounts that can be 
used to send notifications based on different email templates: 
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Here you can add and edit email accounts. Below is an example of "Create New Outgoing Email Account" form:  
 

 
 
At the "Synced email accounts" tab you can manage email addresses synced with TaxWorkFlow. Adding an account 
to this tab allows you to receive email messages straight in TaxWorkFlow application. 
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To add a new email account to the list click an appropriate button. In the appeared window you need to fill all fields 
with a data provided to you by your email service. 
 

 
 
Sometimes your email service provider can block TaxWorkFlow to access your email account. If the email can't be 
synced you need to change your email account settings. Find out how in the next chapter. 
 
At the Calendar Accounts tab you can manage calendars synced with TaxWorkFlow: 
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If you need to add a new calendar click an appropriate button and click "Authorization" in the "Edit Calendar Account 
Settings" form: 
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In the appeared form enter your credentials and than allow TaxWorkFlow to get an access to the data it requests by 
clicking "Allow" button. 
 

 
 
Client Portal tab contains portal URL. Here you can change the "Upload folder" - folder where all uploaded files must 
be placed. Also here you can select who should receive email notifications regarding uploads. Define default 
recipients if necessary and select one of the following options: 
• Send notifications to default recipients only 
• Send notifications to the client representative or default recipients if client representative is unknown 
• Send notifications to both client representative and default recipients 
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Email sync troubleshooting 
 
Sometimes during the first setup of TaxWorkFlow you can get a problem syncing your email account with the 
application. Below you can find out how to address this issue for Gmail account. 
 
If the email can't be synced with TaxWorkFlow check your mailbox using browser. You will find the message like the 
following one: 
 
Subject: Suspicious sign in prevented 
 
Someone recently tried to use an application to sign in to your Google   
Account, ________@gmail.com. We prevented the sign-in attempt in case   
this was a hijacker trying to access your account. Please review the   
details of the sign-in attempt: 
 
Monday, November 19, 2014 8:40:55 PM GMT 
IP Address: XXX.XXX.XXX.XXX  
Location: New York, NY, USA 
 
If you do not recognize this sign-in attempt, someone else might be trying   
to access your account. You should sign in to your account and reset your   
password immediately. Find out how at   
http://support.google.com/accounts?p=reset_pw 
 
If this was you, and you want to give this application access to your   
account, complete the troubleshooting steps listed at   
http://support.google.com/mail?p=client_login 
 
Sincerely, 
The Google Accounts Team 
 
First of all you need to be sure that IMAP is enabled for your Gmail account. Go to "Settings" and open "Forwarding 
and POP/IMAP" tab: 
 

 
 
Set IMAP access as enabled. 
 
To allow TaxWorkFlow access your Gmail account you need to: 
 
1. Open the following link in a browser -  https://accounts.google.com/DisplayUnlockCaptcha 
 

https://accounts.google.com/DisplayUnlockCaptcha
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2. Click "Continue" button. The following page will appear then: 
 

 
3. Now you need to wait for TaxWorkFlow's automatic syncing attempt. 
 
 
Another way to allow TaxWorkFlow to sync with your Gmail account is the following: 
 
1. Open "My Account" from Gmail page, from another Google service or using the link 
https://myaccount.google.com/u/1/ : 
 

 
 
2. Click on "Connected apps & sites": 
 

https://myaccount.google.com/u/1/
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3. On this page turn on "Allow less secure apps": 
 

 
 
4. Now you need to wait for TaxWorkFlow's automatic syncing attempt. 
 
 
Google's 2-Step Verification can also prevent TaxWorkFlow to sync the email. The following error will be displayed 
then: 
 

 
 
 Also if you try to set up your Gmail mailbox as outgoing email and email test failed with the following error the reason 
is 2-Step Verification, too: 
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To turn off 2-Step Verification: 
 
1. Open "My Account" from Gmail page, from another Google service or using the link 
https://myaccount.google.com/u/1/ 
2. Click "Signing in to Google": 

 
 
3. Click on "2-Step Verification": 
 

https://myaccount.google.com/u/1/
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4. Re-enter you password and click "Update Now" button: 
 

 
 
5. Turn off 2-Step Verification by clicking an appropriate button:  
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6. Confirm turning the verification off: 
 

 
 
 
 
 
User management 
 
In this section we will cover how to view, add, delete, or modify user accounts; how to assign different roles for users; 
and how to configure a user to be a default sender for different types of messages, which may be useful to allow 
optimal distribution of the correspondence between staff. 
 
To view a list of users select “Administration”> “Edit users”. 
 
You will be able to see all current users, edit each of them, or add a new one if you have appropriate permissions. 
Click "View Permissions" button to see what options are available for you. 
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To add a new user, click your right mouse button and select a “Create new user” drop-down menu item. To edit an 
existing user select an “Edit selected user” item in the same menu or double-click on the row with the user you want to 
edit. Also you can use buttons on the top of the form to work with users. Below is the “Edit user” form example: 
 

 
 
This form contains several tabs with the following fields: 
 
Account info: 
 
1. User’s “First name” and “Last name”. You can also add user's suffix and title. 
 
2. User’s “Email” address. This address will be used to send email notifications to this user, such as invitations or 

notifications. Please, note, notifications about some activity won't be sent to user who produced this activity. 
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3. “Login” and “Password” to allow users to login into the system. If you do not specify a user’s login you will not be 
able to assign any role to this user and they cannot log in to the system. The “Password” field is mandatory.  

 
4. “Enable user to login into the system”. Change it to "No" to forbid user to login into the system. 
 
5. "Hide user from filters and selection controls". Change it to "Yes" to exclude user from user lists.You will not be able 

to select him/her in any projects/tasks or other program functions. 
 
 
 
Contact info: 
 
1. User's contact info. 
 
2.  The office user is assigned to. 
 

 
 
Roles: 
 
1. “User roles” - There are four user roles that can be assigned: 
• Administrator. Administrators have access to the “Administration” menu item where they can perform various 

workflow, document, and user management tasks such as sending invitations and editing project/task 
templates/properties, document/problem categories, problem templates and problem triggers. Only administrators 
can update the database version and define global templates and company-wide parameters (such as 
authentication methods or office names). Administrators can also perform as Managers. 

• Manager. Managers organize, assign, review, and monitor execution of various tasks and projects across many 
users. They can also communicate with customers via email and mail campaigns. 

• User. Users primarily work on their assignments and documents. Hence, they cannot complete or begin someone 
else’s projects or tasks (unless reassigned), and they also can't run mail or email campaigns. Users cannot delete 
already uploaded documents, prioritize someone else’s projects or tasks, or delete any project. 

• Billing. This is an additional permission which allows to work with Billing/Invoicing module and can be combined with 
any role described above. 

• Work time user. This is another additional permission which allows users to control only their own work time and 
view in read-only mode other user's work time. 

 
2. Advanced options: 
• "Allow other users to complete this user's projects and tasks" should be unchecked if you don't want other users 

complete projects and tasks assigned to this user. 
• “Prohibit this user to complete any projects and tasks” can be checked if you don’t want the user to close any 

projects or tasks. This option may be useful for education purposes, i.e. for trainees or outsourced staff. 
• "Subscribe this user to automatic projects and tasks email notifications" should be checked to allow user to receive 

email notifications regarding tasks and projects. 
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Superiors and Subordinates: 
 
Here you can manage relationships between users. 
 

 
 
To add a superior for selected user click "Add Superior" button: 
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Select a user (superior) from the list and a relation from the drop-down menu. There are following relation types 
available: 
• Supervisory 
• Client Billing  
• Administrative 
 
Please note, each user can have only one superior of each type. 
 
To add a subordinate for selected user click "Add Subordinate" button: 
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Select a user (subordinate) from the list and a relation from the drop-down menu. There are following relation types 
available: 
• Supervisory 
• Client Billing  
• Administrative 
 
Please note, you can't select user's current superior as his/her subordinate. 
 
To edit existing relations double-click on the user from the list of superiors/subordinates or click right mouse button 
and select "Edit superior or subordinate": 
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DocuSign Integration: 
 
In this tab you can turn on and setup DocuSign for the user. Find more information on this feature in "DocuSign 
integration" chapter. 
 



72 

 

 
 
Bulk user reassignment 
 
Bulk user reassignment feature was developed to simplify and speed up the system setup when some staff member's 
role changes or he/she leaves the company. This mechanism allows you to reassign all user's tasks, projects, client 
relations etc to another user. To start the reassignment process click "Administration" >> "Bulk reassign user...". 
Select a user whose relations in the system should be reassigned to another user and click "Select User" button: 
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In the next window you fill find all the objects that have dependencies on this user in the system: 
 

 
 
Click "Next" to proceed. If selected user has some clients serviced by him as client representative the next window will 
propose you to select one of the following options: 
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If selected user has relationships with some clients the next window will propose you to select if you want to reassign 
these links to another user (select user from drop-down menu) or to delete these links: 
 

 
 
The next step is to reassign task templates linked to this user. Simply select a user you would like to reassign all task 
templates to: 
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The next step allows you to close all projects linked to selected client or to reassign these projects to another user: 
 

 
 
Project templates assigned to this user must be reassigned to another user in the next window: 
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Now you can check all actions previously selected. Click "Next" to apply reassignment: 
 

 
 
Upon finishing the process of reassignment click "OK" button to close the wizard: 
 

 
 
Select user form 
 

You can open select user form everywhere where you see the following button:  It can be creating or editing task 
or project or viewing user's problems windows. 
 
This form looks the following way: 
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If you wish to find the user using a search bar, be sure that the column which contains the information you're looking 
for is enabled in the table. This form was created to make your work with users more easy and comfortable. Start 
typing the user's name, email or any other user-related information in the search box and you'll see all appropriate 
results immediately: 
 

 
 
You can sort the list by user id or by user's first or last name: 
 

 
 
Also you can export the list of the users to any format from the list: 
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User activity 
 
You can view each user's full activity in the system by selecting “Administration” >> “View user activity...”. This report 
shows all actions of users affecting all records, so you can monitor the process and find the root cause of an issue if 
something goes wrong. Apply necessary filters and modify grid according to your needs. Also you can save the view 
as a Report. See more about reports in "Reports management" chapter of this guide. 
 

 
 
You can double-click on the report to open the relevant item that was affected during the change. 
 
View/Edit email 
 
To work with email first of all you need to setup your outgoing email. You can find out the information about it in "How 
to edit connection" section of this guide. 
 
TaxWorkFlow contains a number of email templates which you can certainly customize. "Office settings" section 
describes how to edit email templates. 
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Here you can find out how to edit email before sending it to your client. For example, if you need to contact your client 
you select him or her from the list and press "Email Client" button. Here you must select if you want to email a 
taxpayer, spouse or both. Also you can select a email template: 
 

 
 
Below you can find a default template, where all fields but "From" and "To" could be changed: 
 

 
 
You can add text, pictures or macros here. Also you can attach files to your message using an "Add File" button or 
drag-n-drop feature. Test if your email is setup correctly by clicking "Test" button. After the changes done you can 
preview your message. All macros will be replaced by their meanings for this particular client and you could see the 
message that will be sent to the recipient. 
 
Tip: "Enter all macros you wan to use in the message before clicking "Preview" button ("Use 
Macros" button is available). After the preview all macros will be resolved into text and you will not 
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be able to add more macros after returning to editing the message ("Use Macros" button will be 
unavailable)." 
 
Here is the list of macros you can use in the template. 
 
 
 
Sending invitations 
 
This mechanism allows the TaxWorkFlow user with an administrator role to add new users and provide them the 
simplest scenario of how to install the TaxWorkFlow system and activate their personal accounts, so new users won't 
need to edit connection settings in order to start using the program. This feature can also be used to send the 
invitation to the administrator when you first sign up for the new account. 
 
To use this feature, you must log into the system as an administrator and create a new user as described above. Next, 
go to “Edit users” and select the user to whom you wish to send the invitation, and right-click on it to access the pull-
down menu.  
 

 
 
Select the “Invite User to TaxWorkFlow” menu item and you will see the email template that is ready to be sent to the 
user: 
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The email will contain a template with instructions to the user to follow in order to install the application and create the 
connection to your account. This template can be edited and then sent using the “Send” button when complete. After 
the user receives the message, she or he can download and install TaxWorkFlow themselves using the first link and 
to activate their account simply by clicking the second link in the message if they open it in Outlook or Mozilla 
Thunderbird. After that they will be able to work with the program. 
 
Updating application 
 
In TaxWorkFlow we always improve the quality of the application and constantly add new features. We notify our 
customers about the changes in TaxWorkFlow and the need to update the application.  
 
To update your application select “File”> “Update application”. The application will check server for a newer version. If 
your version of TaxWorkFlow is up to date you'll see the following window: 
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Otherwise click "Start Update" button. After the application downloaded TaxWorkFlow will close itself and start 
installation process. 
 
Updating license 
 
Updating license is required for the application if you host your database in-house and your current license is out of 
date. To request a new license click the "License Request" button and email the request text to our support team at 
support@thetaxworkflow.com. When you get a new license simply paste it into the editor of the following window and 
click "Accept" button: 
 

mailto:support@thetaxworkflow.com
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3. Customizing Application 
 

This chapter will help you to customize your application the way you want.  
 
 
Appearance options 
 
You can define the visual style and usability settings of TaxWorkFlow application by using the "Appearance" menu. 
 

 
 
It contains the following options: 
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• Tabbed View - allows you to open windows as tabs so you can always see their captions of all your open 

windows on top of the screen. 
• Show recent menus first - enables you to automatically hide infrequently used menu buttons. 
• Clear menu statistics and layouts - use this option if you need to get initial layouts and clear menu stats.  
• Large font - allows you to enlarge the font of the application to improve text readability. 
• Always confirm on exit - check this option if you always want to confirm your wish to exit the application. 
• Maximize windows - check this option to automatically maximize each window you open. 
• Launch dashboard at startup - this option allows you to launch dashboard when the TaxWorkFlow starts. 
• Autosave layout - check this option to save your menu and table customization automatically. 
• Look And Feel - here you can choose the skin of the application. 
 

These settings are saved on the connection basis, so they will apply even if you run the application on a different 
computer but they will not apply to other connections (in case you have more than one connection in your list). As 
a result, you can also change some options mentioned above going to" File>Edit Connection". Choose the 
connection for what you want to change options and click "Modify" button. Choose "Usability" tab and change 
options: 

 

 
 
Customize table 
 
Tables in TaxWorkFlow are very flexible for customizing. You can add, move or remove columns, group data in 
columns, sort data by any column's content. Let's look at all options separately: 
 
If you wish to add, move or remove some columns of the grid, you can easily do it clicking on the asterisk in the top 
left corner of the grid. Below is an example of a Tasks grid: 
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All unchecked columns can be added to the grid, and all checked columns can be removed from it. To move column 
drag-n-drop it wherever you want inside the grid. 
 
There's another way to manage the columns of the table. Click right mouse button anywhere in the table and select 
"Customize columns". 
The following form appears: 
 

 
 
Now you can drag-n-drop columns from this form to the table. You can choose where to put the column and you can 
also drag-n-drop columns back from the table to this form to remove them.  
 
If you want to filter a visible data of the table click on the key at the right side of the header of the column: 
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For example, below you can find all possible filters for "Return Type" column. Please, note, you can choose more than 
one filter parameters for one column and you can also customize a column's filter: 
 

 
 
You can use as many filters as many columns you have in the table. 
 
To sort the data by some column's content, please, click you right mouse button on the column's header. 
 
"Fix column width" from the same pop-up menu as "Customize columns" allows you to change columns width 
automatically by the system for the best view of the table. 
 
You can save table layout from the same menu if you haven't set to save the layout automatically before. 
 
"Collapse all" and "Expand all" options will work upon you group some data in the table. Below you can find the way to 
do it. 
 
At the top of the table you can notice a space with a following note: "Drag a column header here to group by that 
column". For example, if you wish to group the data by "Task Owner" simply drag-n-drop the header of this column to 
the space at the top. 
 

 
 
To get back to the previous view drag-n-drop the column header back to other headers. 
 

Tip: "You can always see details of grid customization in the info panel above the grid (see 
image below)." 
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You can save the view as a report to get a quick access to it later. Read more about reports in "Reports management" 
chapter. 
 
"Clear table layout" will change table according to default settings. 
 
 
 
 
Menu customization 
 
You can easily customize your menu by adding to or removing buttons from it. Click right mouse button on any icon 
and choose "Customize...". 
 

 
 
The first tab of the "Customize menu" is "Toolbars" where you can manage toolbars of the menu: 
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The next tab is "Commands": 
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It contains "Categories" and "Commands" lists. For each category of the buttons from the left part you can find all 
available commands in the right part. For example, if you want to remove some button from the menu, simply Drag-n-
Drop it out of the menu. You can add buttons from the "Commands" list back to the menu anytime later. Also you can 
save the layout you've made or clear it to get back to default settings. 
 
"Options" tab allows you to manage your usage data and to choose other settings for your comfortable work with 
TaxWorkFlow, such as using large icons, show ToolTips on toolbars, show shortcut keys in ToolTips or to select a 
menu animations. 
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Custom fields 
 
If default set of fields is not enough you can create custom fields applied to clients, projects or tasks. To do this you 
need to open "Administration >> Edit custom field templates...". Click "New Template" button. Next you need to enter 
a field name and select a field type from the list below: 
 
Field Type Description 
Text Any text could be added in this field 
Integer Only integer value could be added 
Float Float value could be specified in the field 
Date Field contains a date 
Time Field contains a time 
Money Field contains a money value 
Yes/No Yes or No value could be selected for this field 
Rating 1 to 5-star rating could be selected for this field 
Single Choice One of many values should be selected from the pre-populated list 
Multiple Choice Multiple values could be selected from the pre-populated list 
 

Tip: "If you select Single Choice or Multiple Choice field type you need to fill out the Value 
Dictionary field. To add a choice simply add a new string in Value Dictionary field. As a result, 
each string of this field will be a separate choice." 
 

Upon the field type is selected you need to determine where this field should be applied to. Below is an example of 
custom fields: 
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Reports management 
 
Reports in TaxWorkFlow allow you to save the view of the table to access this view in a couple of clicks in future. For 
example, each Friday an administrator looks through the list of projects completed within a week by all users of the 
custom office of the company. To see this list he needs to apply 3 filters. Also he prefers to group the results by 
project owner and sort them by project template. Preparing of such report would take some time and also, applying all 
the settings again and again, the risk of any kind of mistake is quite big. Reports resolve these issues.  
 
To create a report you need to manually set it up first. Next you need to click "Reports" button which is placed in "View 
options" group of buttons. Select "Save current table as a report...": 
 

 
 
Name the report, add report description if necessary and click "Save" button: 
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Next time you can easily open this report by clicking "Reports" button and selecting the name of the report from the 
list: 
 

 
 
Reports are available for the following tables: 

• Dashboard Clients 

• Dashboard Projects 

• Dashboard Tasks 

• Dashboard Problems 

• View Clients 

• View Projects 

• View Tasks 

• View Problems 

• View Referrals 

• Email campaign 
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Tip: "Reports created from the Dashboard will be available only on the Dashboard, for example 
if you have created some reports for Clients from the Dashboard you will not see it in the View 
Clients window." 

 
"Reports manager" is a place where you can share, edit and delete reports. To go to "Reports Manager" you need to 
click "Reports" button and select "Edit reports" or go to "Administration > Reports Manager": 
 

 

 
All reports are personal for each user of the system but there is no need to create the same reports for every user 
separately. Select the report you would like to save to yourself or share with another user, click "Copy Report To 
Another User" and select the user you would like to copy this report to. 
 
Select "Reports" >> "Reset Report" to go back to the grid view that you had before applying report(s). Let's look at a 
few examples of how this mechanism works assuming you have a grid without any report applied called "Initial 
Grid": 
 
Sequencing "Reset Report" Result 
1. You applied a report to "Initial Grid" and clicked "Reset Report" "Initial Grid" 
2. You applied several reports to "Initial Grid" consistently and clicked "Reset Report" "Initial Grid" 
3. You saved "Initial Grid" as a report "Reset Report" is disabled 
4. You saved "Initial Grid" as a report and selected another report "Initial Grid" 
 
 
 
 
 

4. Client Management 
 

This chapter contains all information about client management. You'll find out how to add a new client and how to add 
information about your clients to the system. You can also learn how to import your existing clients from Excel 
document. Email and mail campaigns are described in this chapter. All information about how to work with referrals 
can be found here too. 
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Client information tracking 
 
TaxWorkFlow contains a very powerful client management subsystem. Most of the client information flows into 
different program modules, so the completion of all fields is important for efficient communication between clients and 
your staff. It is recommended that as much client information as possible is entered in each client file to maximize the 
functionality provided by the system.  
 
First, let’s see how we can add a new client. Go to the “Clients>Add a new client” main menu item. 
 
You will see the “Create New Client” form. "Edit Client" form looks the same: 
 

 
 
Below is a description of the key blocks in this form: 
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• “Corporate info” – information from this block describes the client’s corporate information such as corporate 
name, client’s position, entity type. For foreign clients you may choose the preferred language from the list. You 
may print this form and send an email message to the client by clicking appropriate buttons on the top. 

• “Tax info” – contains a client’s tax information. Some fields in this box may be used later by the system for 
automatic processing. For example, the “Return type” is used in reports and problem triggers (see “How to 
manage problem triggers”). Also you can select an office and the employee that will service the client. In the 
"Services provided" field you can select services that the office provides to this particular client. 

• “Taxpayer Partner 1” – contains personal primary taxpayer information such as his or her name, date of birth, 
phone numbers, etc. The email address specified in the corresponding field will be used by the system in email 
campaigns if the “Include in email lists” checkbox is checked. 

 
Tip: "If client has several emails you can add multiple comma-delimited emails in the Taxpayer / 
Spouse client record" 
 
• “Spouse Partner 2” – you may specify personal information about the client’s secondary partner or spouse if 

necessary. This block contains the same fields as the previous one. 
• “Address” – this is the postal address associated with the client. It will be used by the system in mail campaigns 

if the “Include in mail lists” checkbox is checked. 
• “Master account” –  TaxWorkFlow uses a master-secondary relationship when creating a client that has many 

businesses that must be tracked together when doing taxes, i.e. for pass-through taxation.  
 
Tip: "Master-secondary relationship allows you to link together personal account of the client 
and his/her businesses. For example we have John Smith personal account and ABC Company 
account which is John Smith's business. Simply keep the personal account of John Smith as a 
master account and setup ABC Company as a secondary account for John Smith. To do this 
you need to open ABC Company record in TaxWorkFlow, scroll down to "Master account:" field 
and select John Smith here as a master account."  
 
Tip: "By establishing master-secondary relationship between business and personal returns, 
you can create custom logic that will make you aware of other entities that need to be included 
in the tax return you are currently working on. For example, you can customize TaxWorkFlow to 
ensure that K-1 Schedule from the person's business return (secondary account) is added into 
the personal return (master account). If this client should be a secondary account then select 
the master account for him from the list of already existing accounts." 
 

Panel on the top of the window contains the following buttons: 
 

• “Save” – saves changes 
• "Save and Close" – saves changes and closes the window 
• “Active” – current client's status. Can be changed to inactive or deleted. By default you can see only active 

users. You can see inactive clients by removing client status filter 
• "Is Prospect" - click this button to add a "Prospect" flag to the client. You can later remove the "Prospect" 

flag by clicking this button again.  
• “Copy to Clipboard” – allows to copy to clipboard taxpayer's address including company name, taxpayer's 

full name and address, spouse full name and address, or client's folder label 
• “Print” – prints content of the window 
• “Email Client” – allows to email taxpayer, spouse or both using templates. 
• “New Referral” – opens "Referrals" tab. 
• “New Associate” – opens "Create new associate" form for client.  
• “Create Project” – opens "Create project" window. Read more about this form in "Projects and Tasks 

Management" chapter 
• “Create Task” – opens "Create task" window. Read more about this form in "Projects and Tasks 

Management" chapter 
• “Add Work Time” – opens "Add new work time" window. Read more about this form in "Time Tracking" 

chapter 
• “Add Note” – adds a new note to client's notes 
• “Add File” – adds file to the database and assigns it to current client 
• “Reload” – reloads window 
• “Help” – opens Help guide 
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• “Close” – closes the window 
 
Tip: "Client can not be deleted if there is at least one task, project, problem or invoice assigned 
to him. The system will request you to close all entities linked to the client before deleting him, 
otherwise deletion is not permitted. Upon the deletion of the client you can't assign any task, 
project, problem or invoice to him. All other actions are still available." 
 

To the left of the form there is a field containing several tabs that aggregate other information under this client 
account. Most of the time this information is automatically collected throughout the life of the record, and displayed so 
you have everything you need when coming back to this record later. By clicking on each of them you will be able to 
see corresponding information regarding only to this particular client. Below is brief description of each tab: 

• “Memo” – you may specify some memos regarding to the client if you wish 
• "History" – shows you all events associated with the client such as opening/closing projects/tasks, adding 

documents and so on 
• “Tasks” – shows you all tasks associated with the client 
• “Projects” – shows you all projects associated with the client 
• "Problems" – contains all problems related to client's projects 
• "Problem Triggers" - contains problem triggers related to the client 
• “Documents” – shows you all documents associated with the client 
• "Notes" – you may specify some notes regarding to the client if you wish 
• “Emails” – shows all email messages sent to the client (only available with the Integrated Email feature) 
• “Referrals” – shows you a list of other clients that your client has referred to you, and whether they were 

referred by someone else, to track the corresponding referral bonuses 
• “Associates” – contains a list of persons related to the client. It can be useful to track other people that need 

to be involved in email communications, such as lawyers, secretaries etc 
• "Client Portal" - contains a form to generate/set/modify user's password to access the portal. Also allows to 

send the password reminder to a client 
• "Custom fields" - contains all the custom fields that were setup for clients. Please see Custom fields chapter 

for more information 
• "User Relationships" - allows to setup relations between staff members and specific tasks for selected user. 

For example you can setup John Smith to be a Reviewer for the client. You can use this setting up a 
workflow of your company. Please see "Managing workflow rules" for more details. 

• "Invoices" - displays all invoices related to the client 
• "Work Time" - contains all work time items related to the client 
• "Payments" - contains all the payments received from the client 

 
You can also add a new client using the "New Client" button in the “View Clients” form. In addition, there is a number 
of operations you can do with the list of your clients. More details about these features will be described in the next 
chapter below. 
 
Working with clients 
 
TaxWorkFlow allows you to view all existing clients and to do a number of manipulations with the list of clients. To 
access the list of clients, go to the “Clients>Clients” main menu item and the “View clients” form will be displayed: 
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Here's a description of the tab: 

• New client – opens a form of a new client such as was described in the previous section 
• Edit client – opens the selected client to view or modify. This is a default menu so you can double-click on the 

row to open the selected client 
• Duplicate client - creates a duplicate of existing client 
• Change client status - allows to activate, deactivate or delete client 
• Change client fields in bulk - opens wizard that allows to change client fields in bulk. For more information see 

"Change client fields in bulk" chapter of this guide. 
• Email client - allows you to select if you want to email taxpayer, spouse or both and opens an "Edit email" tab 
• Select multiple clients - click this button to select multiple clients for further change of their status 
• Create problem - opens problem creation wizard where you can select a task assigned to the client and what 

problem to create 
• Solve problem - allows to solve problem of the task assigned to the client 
• Add work time - opens an "Add new work time" window where you can manually add a work time for this 

particular client 
• Export – allows to export the view to various file formats 
 

You can also find "System" and "View Options" buttons at the top of the tab. There's "Analysis" button among 
grouping buttons which allows you to select what clients to show: 
 

 
 
For example, you can select "Primary taxpayers with both EIN4 and SSN4 missing" filter and the application will show 
you only those clients whose EIN4 and SSN4 are missed. Moreover you can add new filters to each category and 
customize them for your needs. 
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If you wish to add your own filter you can do it in a few clicks. First of all select the type of filter you need. It can be 
"Duplicated attributes", "Missing attributes", "Projects and tasks", "Return type", "Created or updated clients". Then 
click on "Add new filter" menu item. 
 
Creating a filter with duplicated clients' attributes you will be prompted to select what attributes must be the same. You 
can select from one to five attributes at the same time: 
 

 
 
Adding new "Missing attributes" filter select attributes that must be missed for clients you want to find. It can be EIN, 
SSN4 and/or Return type.  
 

 
 
Projects and tasks filter allows you to find all clients without open projects. First select if you wish to find clients who 
do not have an open project of any type or who do not have an open project based on some special project template. 
Then you can exclude from results those clients who have this project completed a certain time ago, just select the 
time in a range from 1 week to 2 years. 
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Clients with the certain return type can be found using a following filter: 
 

 
 
First determine if you want to find clients with a certain return type or with any return type other than a selected one. 
Then you can choose if you want to include in the list clients without assigned master account and/or clients who don't 
have opened projects. 
 
Clients created or updated according to filter rules could be found using "Created or updated clients" filter. 
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Tip: "To get better results searching clients and creating reports you can use Filters, Analysis 
and possibilities of clients grid all together. Also, you can save this view by using Reports 
feature. Read more about it in Reports Management chapter of this guide" 

 
The table of clients can be customized in many ways to make your work with the clients' list simple and to allow you to 
find what you need quickly. Find out how to work with clients grid. 
 
Select client form 
 
You can find "Select client" form when you choose a master account for the client, when you create a new task or 
project and assign it to the client(s). You can also see this form uploading documents or creating a problem trigger. 
This form looks the following way: 
 

 
 
If you are creating project or task you can select multiple clients by clicking an appropriate button. After clicking this 
button a new column "Selected" appears. Using this feature you can create several identical tasks or projects for 
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different clients at once. "Assign Selected Clients" button confirms your choice while "Clear Client Assignment" will 
clear your selection and close the form. 
 
If you wish to find the client using a search bar, be sure that the column which contains the information you're looking 
for is enabled in the table. This form was created to make your work with clients more easy and comfortable. You can 
sort the list by company name, taxpayer last name or by spouse last name: 
 

 
 
You can also find the client by his/her name. Start typing the name in the search box and you'll see all appropriate 
results immediately: 
 

 
 
Also you can export the list of the clients to any format from the list: 
 

 
 
Email and mail campaigns 
 
Email and mail campaign mechanisms can save you time communicating to all or selected clients in your database.  
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Mail campaigns. This function allows you to send messages to your whole list of clients or a subset using a predefined 
email template. Go to the “Clients>Mail campaign” main menu item to activate a mail campaign. 
 
This will open the “Mail campaign” form which contains a list of customers who have a postal address that allows 
inclusion in the mail lists. 
 

 
 
To activate an Email campaign, go to the “Clients>Email campaign...” main menu item. 
 
This will open the “Email campaign” form which consists of three tabs. The “Clients” tab contains a list of all clients. 
"Campaign Problems" column of the grid shows you if the client is eligible for email campaign or not. To move clients 
to email list select clients in the grid and press "Move to emails list" button. Please note, you can select multiple clients 
from the list using "Select Multiple Clients" button: 
 

 
 
You can use a search bar, customizable filters and previously saved reports to find the clients you want to include in 
the campaign.  
 
Tip: "To select all clients from the grid click right mouse button and choose "Select all" option." 
 
The next tab is "Emails". Here you can find all email addresses of the clients and their spouses you've included in the 
email campaign. From here you can preview email(s): 
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Next you need to go to the “Email Message” tab: 
 

 
 
You outgoing email address will be displayed automatically. You may wish to add a "CC:" email addresses using 
semicolon as a delimiter or by clicking the green button to the right of the "CC:" field to make sure that your staff 
and/or some client(s) get a copy of ALL outgoing emails.  
 
Next, specify the message’s subject line and create the message manually or load it from the template using an 
appropriate button. Please refer to Office Settings chapter of this guide to get familiar with template creation  You can 
also attach files to the message. 
 
Tip: "Easily add pictures copied from your internet browser to HTML template. Just copy the image 
and paste it in any place of the message." 
 
Click the “Test to yourself” button to make sure your email settings are correct and the design template works as 
desired. The test message will be sent to your email address. You will see the confirmation dialog after the email has 
been sent to you. 
 
In order to actually run the campaign, click the “Blast to N Addresses” button, where N is the number of clients 
checked in the previous tab. It may take a few minutes before the system processes your list, so be patient and wait 
until the email is complete. Be advised, that emails will be generated separately for each client. If there were no errors 
during the email, the system will notify you about the successful completion of the campaign. All logs are available in 
the "Logs" tab. 
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Referrals 
 
If a client was referred by another client, you can easily reflect this in TaxWorkFlow. Go to the referred client’s edit 
form and open the “Referrals” tab. 
 

 
 
Here you may select one of four referral statuses: not referred, pending, cancelled and applied.  
 
Since some referrals may not result in a new client, these status options help you track if the referred person did 
become your client, in order to grant a bonus to the person who referred the new account.  
 
When a new client is referred to you ("referee"), you select the "Pending" status indicating that you are still evaluating 
this prospect. Select the person who referred him/her to you ("referrer") from the list of your existing clients and set the 
date when the client was referred.  
 
After you qualify this referral, you may select "Cancelled" to indicate that this is not a valid referral, or "Applied" to 
confirm that the referral bonus is due to the referrer. To apply the referral, select the “Applied” status, when he was 
applied and specify the credit. You may enter notes into the “Comments” field to remember the details of this 
relationship. For example, below is a filled form for the client who was referred by Donald Dirks on the 15th of 
November 2015: 
 

 
 
When the referral status changed to "Applied" you will get a notification if you want to select an invoice where to apply 
this referral credit: 
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Click "Yes" and "Select Invoice" window will appear. Here you can find all the invoices created for this client and apply 
referral credit to any of them. If no invoices were created for this client you can click "Create Blank Invoice" button to 
create a new invoice. Upon clicking "Create Blank Invoice" button the invoice will be created and can be found in 
"View Invoices" window. 
 
You can also apply referral credits while creating or editing invoice for the client. Simply click "Apply Referral Credit" 
button and select a referred client from the list. Please note, only clients with "Pending" referral status will be shown in 
the list: 
 

 
 
 
You can list all referrals by accessing the “Clients>Referrals” main menu item. 
 
The “View referrals” forms will be opened. 
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This form shows all existing in the database referrals so you can keep track and reward your loyal customers with 
referral bonuses. 
 
Import clients from Excel 
 
TaxWorkFlow can automatically upload clients from Excel files using a predefined template which is much faster and 
more efficient than manually entering them into the database when doing the initial data population or migration from 
another system. If you have the list of your clients in an Excel file, you can easily use this mechanism. 
 
Select “Clients>Import clients from Excel”. 
 
Load an Excel file using an appropriate button at the top of the tab. You can find an example below where the first row 
of the file is a header: 
 

 
 
If your file doesn't contain the header, and the first row already contains client's data, then you need to uncheck "Use 
First Row As Header" button.  
 
Press "Transfer Data" button moves the data from the Excel view into the client database view. 
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After the data is transferred, you can merge some columns according your needs. For example, if you have two 
columns in your document, one of them contains a phone number and another one contains a telephone extension 
you need to merge them into one column. Drag one column and drop it to another one, select the delimiter and 
approve merging. After all merging operations done you need to map fields of Excel columns and database columns. 
Use "Map Fields" button for this purpose. Below is an example of field mapping tab: 
 

 
 
When all fields are mapped you need to check the data for errors in values. Press "Validate Values" and if you have 
some errors you will be able to change incorrect data or to clear it. 
 
Keep "Reconcile Existing Clients" button pressed if you want the application reconcile imported and existing clients to 
avoid importing clients that already exist in the database. If the application finds the same client(s) in the database 
you'll see the screen like the following one: 
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Here you can select a client from the list and decide if you want to keep old values for this client, to merge all values or 
to replace old data. Also you can skip this record or create a new client in the database. 
 
Now you are ready to import the data. Press "Import" button to complete the import of the values into the client 
records database. 
 
Working with clients grid 
 
Clients grid has many columns available to view. Usually not all of them are useful for user. To view all available 
columns click on the asterisk in the left top corner of the table: 
 

 
 



109 

 

Some of these columns consolidate information from other columns to make your work with the application easier. 
"Primary Taxpayer / Partner 1" field consolidates clients first name and last name. "Spouse / Partner 2" field 
consolidates spouse's first name and last name. Another one field is "Full address" which consolidates client's 
address, city, state and zip. All these fields are displayed by default. "Consolidated Client Name" field consolidates 
"Company" and "Primary Taxpayer" fields. It is not displayed by default but you can easily make it visible by checking 
a certain box. 
 
Also you can filter a grid by any value of the column. In the example below you can see a grid filtered by return type 
1040: 
 

 
 
Moreover you can group all records of the grid by any column. Just drag a column header up in the space marked by 
green arrows:  
 

 
 
To save your grid to use it in future you can save it as a report. Read more about reports in "Reports Management" 
chapter. 
 
"Export selection to clipboard" and "Import selection from clipboard" options allow you to simplify you work with 
multiple clients. Click "Select Multiple Clients" button, select clients from the list and click right mouse button to select 
"Export selection to clipboard". Choose the column to export and click "OK": 
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This feature could be useful in a number of situations. For example, you have setup your clients grid someway and 
want to do an email campaign for these clients. Now you need to select all these clients, copy "Client ID" column to 
the clipboard, go to "Email campaign" window, click "Select Multiple Clients", click right mouse button on the list of 
clients, select "Export selection to clipboard", select "Client ID" (the column that you copied to your clipboard earlier) 
and click "OK". Now all the clients selected in the first window will be selected in Email campaign window: 
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Also, this feature could be useful when you work with 3rd party accounting applications or services. One more 
example: in Lacerte you have a list of clients who have some tax refunds and you want to do an email campaign for 
them. You can export this list to Excel, select some column with unique values (e.g. email), copy this column to 
clipboard. At the email campaign window you can click "Select Multiple Clients" button and import selection from the 
clipboard (list of emails from Excel). Point out that you are importing "TP Email" column and click "OK". Now all the 
clients from Excel list will be selected in the email campaign list (assuming all clients from Lacerte exist in 
TaxWorkFlow database) and you can move forward. 
 
Change client fields in bulk 
 
Sometimes there is a necessity to change same field(s) of several clients. To avoid time-consuming one-by-one 
change you can use "Bulk change client fields" wizard. Click "Change Client Fields" button in the "View Clients" 
window and select clients you want to change field(s) for: 
 

 
 
The next step is to select what fields you would like to change: 
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Please note, only for fields are available for bulk change: 
 
• Client Representative 
• Office 
• Entity Type 
• Return Type 
 
When the field to change is selected click "Next" and choose if you want to select another value for the field (eg. 
assign clients to another office) or clear selected field: 
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Upon clicking "Next" button you can see a summary of changes that will be applied to selected clients: 
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The last window contains the information about all changes applied: 
 

 
 
Click "OK" button to close wizard. 
 
 
 
 
 
 

5. Document Management 
 

Work with documents is completely described in this chapter. You can find out how to search for documents, how to 
organize them and deliver to your web-site or to CD/DVD. You can also learn all possible ways of uploading 
documents to the system. 
 
 
Finding documents 
 
You can find any uploaded document in the system by using the “View Documents” form. Go to the 
“Clients>Documents” main menu item to display this form. You can put documents into folder so you can navigate the 
tree and quickly locate the document you are looking for when you click the folder. Numbers in brackets show the 
quantity of documents in each folder and its subfolders. If you prefer to exclude subfolder's documents and to see only 
the number of documents in the current folder pull-down the menu by right-clicking on the selected folder and uncheck 
"Count documents only in folders themselves". You can apply additional filters to the list of documents using "Filters" 
button. 
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From this menu you can also add a document to this folder, create a new PDF document, edit folder, hide private 
client's folders, hide empty folders, show all documents in all folders, expand/collapse all folders, export documents 
and reload the folders tree. 
 
To operate with documents pull-down the menu by right-clicking on the selected document. 
 

 
 
This menu contains a number of commands you can run on the document or multiple documents: 

• Add document – allows to upload the file to selected folder 
• Create a new PDF document - opens "Create PDF Document" window 
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• Delete document – deletes the document 
• Rename document – allows you to change the title of the document 
• Open document by default program – opens the document using the default program configured by your 

system for this type of files 
• Open document using TaxWorkFlow –  opens the document with a built-in editor for this type of files. You can 

go to "File" > "Connection Settings" > "File Associations" tab to associate different file types with TaxWorkFlow 
or external program. Read more about it in "How to edit connection" chapter 

• Save document - saves selected document to the local disk 
• Publish document – publishes document(s) to the "Published documents" folder of the Client Portal (if 

available). You can find more information in "Client Portal" chapter 
• Publish for signing via DocuSign - publishes document(s) to the "Awaiting your signature" folder of the Client 

Portal (if available). You can find more information in "Client Portal" chapter 
• Email document to client – allows you to send the document as an attachment to taxpayer, spouse or both 
• Move document to another folder – opens "Edit Document Properties" window. From here you can change the 

document’s title and folder, publish document to Client Portal, send notification about portal publication or email 
document as attachment 

• Move document to – moves document to another folder, it allows you to select document’s folder from the 
expanding menu item 

• Assign document to another client - opens "Select Client" window. Here you can select a client that selected 
document should be reassigned to (in case it was filed to a wrong client) 

• Add work time for document - allows you to add a work time for this particular document 
• Export – exports the list of documents to selected format (XLSX, XLS, XML, TXT, HTML) 
• Print - sends selected document to printer 
• Multiselect mode - allows you to select several documents. "Select all" and "Unselect all" commands simplifies 

your work in multiselect mode 
• Reload – refreshes this list 

 
Organizing documents 
 
You can change the folders tree as you wish. Select the “Administration>Edit document folders” main menu item and 
you’ll see the following form: 
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On the left side of the form you can see a folders tree. Click your right mouse button on this field to add folder, add 
child folder, modify, duplicate, or hide the selected folder. The right side of the form contains the selected folder’s 
settings.  

• Folder name – specify the name of a folder here as it will be displayed on the tree 
• Assign the document to a client - allows you to assign an uploaded to this folder document to specific client 
• Email this document to the client as an attachment using the "Client Email Template" - check this box and each 

published document will be mailed to the client as an attachment 
 
The following features will be available in future releases soon: 
• Publish this document to the portal into the client's account – by checking this box you set up the system to 

publish all uploaded documents from this folder to web portal automatically (available only with the Integrated 
Web Site) 

• Email to the client about this publication using the "Portal Publication Email Template" - allows you to notify the 
client that document is ready and was published to the portal 

 
If you want to hide some folder which contains documents, you can choose what to do with them. You can hide them 
with the folder or move them to another folder: 
 

 
 
Click “Show Hidden Folders”, right mouse button click on any hidden folder will allow you to unhide it: 
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Uploading documents 
 
There are several ways to upload documents to the system.  

• You can upload documents from the project’s or task’s edit view by clicking the "Add File" button at the top of 
the form: 
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• You can upload documents from the “View Documents” form by clicking "Add Documents" button at the top of 
the form. Another way is to select a folder, click right mouse button at the field where uploaded documents 
shown and select “Add document…” or you can click right mouse button straight on the folder in the folder's tree 
where you want to add the document. 

 

 
 

• Documents can be uploaded from the client’s view form at the “Documents” tab in the middle of the form. Click 
your right mouse button at the field and choose “Upload document” from the pop up menu:  

 

 
 

• You can select "Clients >> Import documents from folder..." to import several documents at once. Before 
importing make sure that folders are named by client's names to whom they are intended. If you want to import 
a folders tree name folders inside the client's folder accordingly to the folders tree from the database. Find the 
"importing documents from folder" form below: 
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• You can drag-and-drop documents to the “View documents” form which was described in the “Finding 

documents” section. 
• Documents can be uploaded automatically from your PC. Special application - TaxFlowService will 

automatically make replications of all folders from TaxWorkFlow so if you scan a document and save it in some 
replicated folder (for example, /Tax Year 2013/DRAFT 2013) this document will be automatically uploaded to 
TaxWorkFlow to the folder with the same name. You must save files in a special way mentioning customer’s id 
in the name of file so it’ll be stored for this customer in TaxWorkFlow. After the document was uploaded you’ll 
get a notification to your email about it. 

• You can print document in PDF format straight to the database from any editor using PDF printer. 
 
Please note that you can use drag-and-drop in all uploading scenarios as well. 
 
Uploading the document you need to choose a client and a folder for it. Client will be selected automatically if you 
attach files to project or task related to this client: 
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Tip: "Uploading several files click "Apply this selection To Remaining Files" button if you need to 
store all files in one folder." 
 
You can use documents in "Problems". For example, if you need to get some payment for a baby, the customer must 
send you a birth certificate. You can create a project problem and TaxWorkFlow won’t let you close the project until 
the document was sent to you and you close the problem. See more about projects at “Projects and Tasks 
Management” and more about problems at “Problems Management”. 
 
You can find out who and when uploaded some document in "User activity" window. Find out more information about 
it in "User activity" chapter of this guide.  
 
Create PDF document 
 
TaxWorkFlow allows users to compose PDF files from any images including those captured from scanner. Built-in 
OCR and image quality tools are able to make your PDF files text searchable and keep the best quality of images 
along with a high compression level. 
 
To create a new PDF file you need to go to "Clients" > "Documents" and click "Create PDF Document" button. This 
button is also available from the Dashboard. 
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First you need to setup document properties. This will save your time as all images you add to the document will be 
processed according to these properties straight upon you add them. You can change properties later if you need. 
 
Tip: "Set document properties before you add images to the document. You can change properties 
anytime later but this will require additional time to re-compress and re-OCR all the images of the 
document. If you have a doubt about settings, add one image and play around with the document 
properties. When you're satisfied with the quality and size of the image go ahead and add other 
images to the document." 
 
Properties block contains the following sections: 
 
1. Document Information 
2. OCR & Image Quality 
3. Permissions And Security 
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1. In "Document Information" section you can edit document title, author and paper size. 
 
2. "OCR And Image Quality" section contains the following settings: 
 

1)  "Quick Settings" - allows you to apply presets from the list below: 
• Original - keeps original compression and resolution. OCR is turned on. 
• Color Document - sets compression to JPEG 50% and resolution to 150 dpi. OCR is turned on. 
• B/W Document - sets compression to JBIG2 (lossless) that allows you to significantly decrease the file size, 

keeps original resolution and forces grayscale to ON. OCR is turned on. 
• Picture - sets compression to JPEG 50% and resolution to 150 dpi. Turns off OCR. 
• Screenshot - sets compression to PNG and keeps original resolution. Turns off OCR. 
• Web Image - sets compression to JPEG 25% and resolution to 72 dpi. Turns off OCR. 
• Custom - allows you to select your own settings that are not included in the presets list. 
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 Please note, all presets were designed to maximize the quality of images and minimize their size. 
 

2)  "Compression" - allows you to select a compression from the list below: 
• Original 
• PNG 
• JPEG 100% 
• JPEG 75% 
• JPEG 50% 
• JPEG 25% 
• JBIG2 (lossless) 
 

3)  "Resolution" - allows you to select one of the following resolutions: 
• High (300 dpi) 
• Print (150 dpi) 
• Screen (96 dpi) 
• Web (72 dpi) 
 

4)  "Force grayscale" 
 
5)  OCR language - allows you to select OCR language or turn OCR off by selecting "No OCR". To add languages 

to the list you need to open "File" > "Install OCR languages...", select languages that you need to install by 
marking them as ON and click "Start Install" button.To delete languages from the list you need to mark them as 
OFF in the list: 

 

 
  
When you're ready with document settings you need to compose a document. There are several ways to add images 
to a document: 
 
1. Click "Add From <your scanner name>" button to scan an image and put it into the document 
2. Select you smart phone or digital camera in the list of scanners to add images from it 
3. "Add From File" button allows you to add images from your disk or network places 
4. Drag-and-drop files from your file system onto the document (left pane on the screen) 
5. Copy the image and paste it into the document 
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To add images from your smartphone you need to select it in the list of scanners. The tree view of all images will 
appear. You can change it to list view which is helpful if you need to sort files by timestamp independently of the folder 
they are stored in: 
 

 
 
You can also use "Search" bar to find images by name. Composing the document from images from your 
smartphone/camera you can drag and drop them to the left pane, you can select multiple images and put them in any 
place of the document. 
 
Each image of the document can be rotated by 90, 180 and 270 degrees. Also you can drag and drop pages from one 
document to another, or even drag and drop the whole document to any place of another document. 
 
Besides the documents and their pages the left pane contains a list of sources and an information about OCR jobs. 
When you add a bunch of pictures to the document and OCR process starts you can see what documents are already 
OCR-ed and what documents are still in process: 
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If you need to check the OCR results you need to click right mouse button on the page you'd like to check and select 
"Show output text...". A new window with OCR-ed text will be opened. Below is an example of this window and OCR 
output: 
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You can copy text from here or save it to text file or print if necessary. You can also look for some text on this page. 
 
Usually there is no need to use a set of "Performance" buttons but sometimes they could be helpful. 
 
"Disable OCR" button allows you to stop OCR process and compose a document without OCR-ing it. Once the 
document is composed you can enable OCR and the process will start immediately. 
 
"Disable Refresh Upon OCR" button is helpful if you are reading a newly composed document. During OCR process 
your document will be refreshed as much times as much pages it contains. It will show you the first page upon each 
refresh and it makes impossible to read the document. This button disables refresh of the document upon OCR so you 
could familiarize with the document and enable refresh only when you're done with the document and the refresh will 
not distract you. 
 
"Conserve CPU" button would be helpful for pretty old computers. By default OCR uses all cores of your CPU. Each 
core works on one page at a time. By clicking this button you will increase the time of OCR process but at the same 
time your CPU will be loaded less and your computer will be available for other CPU-dependent actions. 
 
"Conserve Memory" button turns on a memory saving mode. The application keeps cached images on disk instead of 
placing them in the memory. It could be helpful if you have a low memory reserve or if you are working with big 
documents that can significantly increase memory usage. This mode turns on automatically if the document contains 
25+ pages. 
 
Import documents from folder 
 
TaxWorkFlow can automatically upload documents from any folder of your PC. 
 
Select “Clients>Import documents from folder”. 
 
First select a destination folder: 
 

 
 
Next select source file directory: 
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Now you need to map loaded directories to clients. Press the appropriate button and assign a client for each directory 
from the list. 
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Check all rows you would like to import and press Import documents button: 
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Now all documents were uploaded to the system and assigned to clients. 
 
PDF printer 
 
PDF printer is a simple way to upload your file in PDF format straight to the database from any editor. This printer is 
installed during the TaxWorkFlow installation process. In the same topic you can find how to setup your firewall in 
case it blocks the installed printer. 
 
To upload a document to the database in PDF format send it to printer and select a TaxWorkFlow PDF Printer from 
the list of available printers. Depending of the application you're using this dialog may look in different ways. When the 
printer is selected and you see that it's ready you need to click "Print" button. 
 
Then you will be prompted to select a folder for the document. Also you will need to enter a document title and assign 
a document to the client: 
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Check "Automatically publish the document" if you wish it was available to the client from the portal. 
 
Click "Save Document" button and PDF will be uploaded to TaxWorkFlow database. 
 
If you need to protect your documents with a password you must setup your PDF printer respectively: 
 
Go to Control Panel >> Hardware and Sound >> Devices and Printers. Right mouse click on the TaxWorkFlow PDF 
Printer and select "Printing preferences": 
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Select PDF Properties tab, check "Password-protect the documents" and select one of the following options: 
 
• prompt for password each time 
• automatically protect with the default password 
 
Set default password if necessary and click OK 
 

 
 
Delivering documents 
 
You can deliver multiple documents using each of the following ways: 
1. via CD-ROM.  
2. via a Client Portal (if available).  
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All manual delivery options are available from the client’s view form at the “Documents” tab in the bottom of the form. 
Click your right mouse button at the field to see the following context menu: 
 

 
 
From here you may publish documents on the Client Portal or burn them on a CD-ROM. Also you can email 
documents to taxpayer, spouse or both. Find the description of all available options at "Finding documents" chapter. 
 
You can configure the system to publish documents on Client Portal automatically. Moreover, if you use 
TaxFlowService to upload documents it will automatically publish them to web-portal if you checked “Automatically 
publish documents in this folder to web-portal” box. This feature was described in details in the “Organizing 
documents” section. 
 
 
 
Export documents 
 
To export documents from any folder of TaxWorkFlow to local disk you need to go to to the “Clients>Documents” and 
pull-down the menu by right-clicking on the selected folder: 
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Select "Export documents" to open an export wizard: 
 

 
 
Select local folder where you want to export documents: 
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The final step is to click "Export Documents" button: 
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When export is finished you can see all exported documents in selected local folder. Documents will be saved in 
subfolders named by your clients full names. Please note that it may take a while till all documents are 
retrieved/saved. 
 
 
 
 
 

6. Projects and Tasks Management 
 

From this chapter you can learn what tasks and projects are. How to organize tasks into projects, to manage projects 
and all workflow rules. 
 
 
Custom task 
 
The simplest piece of work is a task. It’s usually a one-time event such as: call client, print tax return, review file. In 
order to create a new task, you can select “Workflow”> “Create task” or simply press Ctrl+F5. 
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To select a client/office you can use a "Select client form" / "Select office form" or use the drop-down menu.  
 
Tip: "Office selected on this step can be changed in future when task is already created but you 
can not reassign task to another client upon it's created" 
 
To assign tasks to your staff or to yourself use a "Select user form" or a drop-down menu. Also here you can 
determine a deadline and choose a priority of the task. Then you can add instructions for this task and attach notes 
and files if necessary (drag-n-drop option is available). 
 
Keeping track of tasks 
 
To see all created tasks go to “Workflow”>“View tasks” or press F5. 
 

 
 
At the picture above you can find a list of tasks assigned to all users. There’s an option to show just special tasks that 
are part of a project (choose it from the drop-down menu). Also, you can check/uncheck “Options” checkboxes to 
adjust how much information you want on this list: 
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Tip: "Click "Select Multiple Tasks" button to complete, fail or reassign multiple tasks at once." 
 
Once you select a task in the list, you will be able to quickly adjust its status by using the action buttons. 
 
The “Begin Work” and "End Work" are used to keep track of the time you spend on this task. Also you can add work 
time using an appropriate button. Learn more about Time Tracking here. 
 
"Edit Task" button allows you to edit the selected task: 
 

 
 
"Save" button will save all changes in the task. 
 
The “Complete Task” closes the task and (if it was part of a workflow project) creates the new task that follows the 
route of the workflow execution.  
 
The “Reassign Task” button allows you to assign the task to another user of the system if you have a permission for it. 
You can add reassignment note in this form. You must select a user to reassign task to and determine a priority of the 
task. 
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The “Fail Task” button will close the task but in the e-mail notifications and in logs you will find that task wasn't 
completed but failed. If the task is a part of a project it will downgrade the project. It reverses the flow backwards, 
moving the project a step back. It's the opposite of the Complete Task as it restarts the old task (i.e. when the 
processor needs to go back and redo the preparation work). 
 
The "Edit Project" button allows you to edit a project from this tab if the task is a part of the project. 
 
The "Edit Client" button helps you to edit the information about the client from the tab. 
 
Click on "Task Permissions" to see what operations you can do with the task: 
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You can also group this list by permissions: 
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The “Problems” shows if there are any pending problems blocking the further execution of the project. If this button is 
active, it means that you cannot complete the task until you solve the problem. The problems are discussed in greater 
detail below. 
 
You can re-prioritize the tasks. The primary information about each task such as deadline or status is also available in 
this window. 
 
If you completed or failed the task you can find it upon editing filters. By default you can see open tasks only: 
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Completed custom tasks (tasks that were not a part of any project) can be reopened. Open it in "Edit task" window 
and click "Reopen Task" button: 
 

 
 
Please note, you can't reopen tasks that were a part of the project. If the project contained the task is complete you 
need to create a new same task but if the project is still open you can downgrade it to this task. 
 
Organizing tasks into projects 
 
As your staff and amount of work grows, the amount of tasks may become difficult to manage, especially when one 
task will depend on another. 
 
In order to deal with task dependencies and manage your teamwork better, you can organize typical tasks into 
"projects". A project is composed of 2 or more tasks. It’s a preprogrammed set of instructions that tells staff how to 
work in a sequential order. Projects help reproduce the same sequence of steps over and over again for various 
customers. These steps reflect your business practice, i.e. who and how is involved with this activity. Projects are 
based on project templates that define the behavior of the project.  
 
To create a new project based on an existing template select “Workflow”> “Create project” or simply press Ctrl+F6. 
First you must choose a project template from the list of enabled projects, a client, assign a project owner, determine a 
deadline. If the project is recurrent you can set owners for projects that will reoccur. Also for recurrent projects you can 
select if you want to copy project instructions from previous projects or from original project template. You can fill 
“Project Instructions” and “Task Instructions” fields, however they will be populated by default project and task 
instructions defined in your workflow template. You can also attach files to the project (i.e. input files from the client, 
such as expense reports, stubs, bank statements, etc.). Below is an example of the project: 
 



143 

 

 
 
Tip: "If you can't find necessary project template please check its status at "View Project 
Templates" window. Project template must be enabled to appear in the list of available project 
templates." 
 
Here is an example of tasks of previously created project: 
 

 
 
In this example, each scheduled task of the new project has its own order number. You move over to the next task in 
the queue after you complete the current task. That is called "upgrading the project", i.e. advancing the project up the 
schedule pipeline of tasks until the project concludes. You can upgrade project, for example, from “prepare” to 
“review” status, and the prepare task will be closed automatically. Downgrading the project means the step back, e.g. 
from “review” stage back to “prepare” stage. 
 
To select a client or office you can use a drop-down list or special forms. They are available by clicking the appropriate 
buttons to the right of the fields. 
  
"Select client form" allows you to select multiple clients to create several identical projects at once for selected clients. 
Find out more information about "Select client form" "Select client form" chapter. "Select office form" is described in 
the relevant topic. 
 
Tip: "Office selected on this step can be changed in future when project is already created but you 
can not reassign project to another client upon it's created" 
 
Another useful feature is the "fast-forwarding" of a project. It means you can move the project state over to any task of 
the project (not necessary to the next one or previous one). After the fast-forward procedure all tasks in the queue 
before the chosen task will be skipped if you choose the future task. If you choose some previously completed task all 
task completed after it will be reset to initial state and scheduled for future completion. You can fast forward a project 
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by selecting the task from the queue and clicking on the right mouse button and selecting "Fast forward project to this 
task": 
 

 
 
You can also fast forward project from the "View tasks" window. Select the task of the project that you want to fast 
forward and press the fast forward button: 
 

 
 
In the new window you can select a task to which you want to fast forward project, as well as make other changes in 
the project, i.e. change the owner, priority or instructions. 
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Each task of the project and a whole project itself can be assigned or re-assigned to any user of the system. Future 
tasks can be supplemented with special instructions and assigned to different staff on the individual basis. This gives 
you the power of the "fire and forget" concept that allows you to schedule the work in advance and then have it done 
according to your plan. 
 
Some projects need to be repeated on a specific time basis. In this occasion you must create a project with 
recurrence. Recurrent project will be automatically re-created by the system on a time basis you define. For example, 
the project can be re-created each year if you make this project template recurrent. Pay attention to "Recurrency" 
block below: 
 

 
 
Here you need to select a first project start date, it'll be automatically created that day and than it will be automatically 
re-created each year, the application will show you the creation schedule. 
 
You can also set an automatic deadline to the project. Click "Set Automatic Deadline" button on the top of the "Edit 
project" window: 
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You can link the deadline to project period end, project start date or select a custom month and day. Also you can set 
the deadline to be moved to any day of the week if the due date fails on Saturday or Sunday. 
 
Later you can change the deadline of particular project by clicking "Change Project Deadline" button. 
 
Also you can select from where to initialize task owners and instructions for new projects by clicking "Set Owners and 
Instructions Copy Rules" button: 
 

 
 
For example, if you select "The previous project" the new project will keep all changes you performed during the 
completion of the previous project while with selected "The project template" the new project will appear with default 
task instructions and owners.  
 
Tip: "Keep owners and instructions from the previous project can be useful if you have multiple 
clients and there are some specific instructions for several of them. With this option you don't need 
to duplicate project templates for each specific client separately." 
 
To stop recurrent project you need simply to click an appropriate button that appears after the project is created: 
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Select office form 
 
You can open "Select office" form clicking on the icon near Office's drop-down list when you create a new task or 
project. This form looks the following way: 
 

 
 
If you wish to find the office using a search bar, be sure that the column which contains the information you're looking 
for is enabled in the table. This form was created to make your work with offices more easy and comfortable. Start 
typing the office name, city or any other office-related information in the search box and you'll see all appropriate 
results immediately: 
 

 
 
Also you can add a new office to the system from here or edit an existing one. "Export" button allows you to export 
existing offices to any format from the list: 
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Click "View Permissions" button to see what actions are allowed to you: 
 

 
 
Tip: "Office can be changed in future when the task/project is already created." 
 
Managing projects 
 
In order to view the current status of projects go to “Workflow”> “View projects…” or press F6. 
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From here you can add, edit, complete and delete projects. 
 
Click "Reassign Project" to change project owner. 
 
Click "Select Multiple Projects" to be able to select a bunch of projects for such actions as "Complete Projects", 
"Delete Projects", "Reassign Projects": 
 

 
 
"Stop Recurrency" button allows you to stop selected project's sequence from reoccurring. 
 
"Add Work Time" button will open "Add new work time for project" window for selected project. Read more about it in 
"Time Tracking" chapter. 
 
Clicking "Project Permissions" button you can find out what you can or can not do with the certain project:  
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You can filter projects by following parameters: 

• Project owners 
• Project status 
• Project deadline 
• Project office 
• Project template 
• Project year 

 
Double-click on the project to obtain more information about the project: 
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In this view you can: 

• Complete project 
• Reassign project to another user 
• Fast forward project to selected task 
• Delete project 
• View future project (for recurrent projects) 
• View project permissions 
• Add files and notes to the project 
• Add work time 
• Set automatic deadline - set or change a deadline for current project. 
• Stop recurrence of the project 
• Set workflow initializing rules - the rules how to initialize task owners and instructions for new projects 

that will reoccur 
• Create custom task 
• Edit, complete or fail selected task 
• View selected task permissions 
 

Tip: "Creating custom task option will add a new task for current project. This will not be reflected 
in project's template when you create them or when they reoccur automatically. If you want to add 
a task to the project template permanently you need to change a project template workflow." 
 
Additional information about the project can be found in the tabs at the bottom of the window: 

• Overview - shows current project instructions 
• Project instructions - place where you can edit instructions for the project 
• Project tasks - contains information of all tasks of the project and allows you to manage them 
• Problems - list of problems related to project 
• Sequence - available for recurrent projects only. Here you can find all previously occured projects and 

future project 
• Attachments - here you can view, add and delete attachments of the project 
• Emails - all emails linked to this project will be shown here 
• Notes - here you can add, open or delete notes regarding the project 
• History - contains all operations that were produced with the project 
• Custom fields - contains custom fields previously created. For more information see Custom fields 

chapter. 
 
In this view, you can find all information about project, change the deadline, stop recurrence of the project, reassign 
project, view all tasks to be done, add file or note to the project (drag-n-drop is available), modify the instruction and, 
of course, upgrade, downgrade, fast forward and complete project. You can also view completed/scheduled tasks by 
clicking on them. In addition, you can view, create, or solve problems associated with this project. "Add Work Time" 
option is also available from this window. 
 
In addition to obtaining a current snapshot of the projects, you can also track the history of each project to see how it 
is progressing. Go to “Workflow”> “View projects activity...” to view the project activity report. 
 
Here you can filter projects from the list by the user to whom they were assigned to. Selecting the appropriate project 
in the list, you can find all related activity information in the field below. 
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Tip: "Sometimes you need to assign one task or project to a few persons. You can't do it in the 
application but you can create a special user, eg Back Burner. Than you can ask some members 
of your staff to take care of his projects and tasks. Please note, you need to make this user active 
and to allow other users to complete user’s projects and tasks." 
 
Managing workflow rules 
 
As you learned above, projects are created based on the rules, or "Project templates". Select “Administration”> “Edit 
project templates”. Here you can add, modify, delete existing project templates. Please note, "Tasks" column contains 
a number of active tasks for each project template. 
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To edit project template you can double-click on it or select it in the list and click "Edit Project Template" button: 
 

 
 
In "Project Assignment Rules" category you can select a default project owner. It may be a specific employee or a 
client representative - the employee who services the client personally. 
 
In "Workflow Rules" category you can change special workflow rules, such as: 
 
 1. Creation of the projects based on selected template 
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• "Require client be assigned to projects of this template" - the project can't be created without a client assigned to it 
• "Automatically create first task on project creation" - the first task will be created automatically. If this checkbox is 

unchecked you need to upgrade project manually 
• "Automatically create the helper task to review project workflow if this project is created automatically" - check this 

box to add one more task to all automatically created projects. This additional helper task will allow you to review the 
workflow to make sure it fits for this particular project 

• "Add invoice item upon creating project" - allows to select the item account for this project and invoice item cost 
 
 2. Completion of the projects based on selected template 
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• "Require administrator or manager privileges to complete projects based on this template" - only users with 

administrator or manager role can complete projects based on this template 
• "Create a new non-recurrent project on project completion" - this option allows you to create a project based on 

another project template (without recurrency) automatically after the project based on current project template is 
completed. Also you can specify clients for whom the new project must be created 

• "Prompt to enter quick note when closing this project" - opens a "Quick Note" window after the project is completed 
to ask employee to leave a note regarding closed project 

• "Prompt to review the client invoice upon project completion as the result of billable work" - opens an "Edit Invoice" 
window with an appropriate invoice after the completion of the project 

• "Prompt to enter work time upon completion of this project" - opens "Add New Work Time" window to edit a time 
spent working on the appropriate project 

 
 3. Deletion of the projects based on selected template 
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• "Prompt to enter quick note when deleting this project" - opens a "Quick Note" window upon the project is deleted to 

ask employee to leave a note regarding deleted project 
 
In "Recurrence and Deadline" category you can add recurrence to the certain project which means that this project will 
be re-created automatically by the system on a certain time basis: 
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Tip: "You can not add a recurrence to those project templates that are already setup to be created 
as a new non-recurrent project on another project completion." 
 
Creation rules category contains an option that allows you to select if you want that for new projects created as part of 
recurrency series, owners and task instructions for project itself and its tasks are copied from: 
1. The previous project (new project will keep all the changes you performed in the previous one). 
2. The project template (stay permanent independently of changes in the existing project)  
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You can also set an automatic deadline option here. It will set the deadline for each new project automatically. If the 
project is recurrent you can set the deadline before its expiration date. 
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Project period tab allows you to setup a rule for project period determination: 
 

 
 
Client email template tab allows you to setup a notification email template that could be manually sent to the client 
upon the project based on certain project template creation: 
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To automatically specify project's details you can use macros in the subject and body of the email. You can find 
macros available for this template in Appendix A of this guide. Outgoing email for the template can be set in "Office 
settings">>"Email Templates" window. 
 
Tip: "Use global outgoing email to send project creation notifications. This will allow application to 
send notifications for reoccurred projects automatically." 
 
"Default Project Instructions" tab contains the instruction for current project template: 
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"Edit Project Template Workflow" button opens a list of tasks that project is composed of. Editing workflow means 
defining the task templates and their sequence within the project. You can add a new task template, delete task from 
the workflow or change an order of tasks in the project using the form below: 
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This window can also be opened by selecting "Admistration" > "View task templates". 
To edit the task properties you need to select a task and click "Edit Task Template" button. 
In "Task Assignment Rules" tab you can select a default task owner or select an assigning rule for this task. Please 
note, you can't assign the first task of the project to the employee who completed/failed the previous project task or 
fast-forwarded project to this task. 
 

 
 
In "Workflow Rules" tab you can set a numerous workflow rules for this particular task: 
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• "Require manager to complete or fail this task" - only administrator or manager can complete such kind of tasks 
• "Do not upgrade project upon the task's completion" - after the task is completed you need to open the next task in 

the project manually by upgrading or fast-forwarding the project 
• "Move to the following task upon task failure" - allows you to automatically change a project scenario in case the 

certain task was failed 
• "Create the following non-recurrent project upon task completion" - allows you to create a new non-recurrent project 

automatically after the task of this task template is completed. You can specify this rule for a selected list of clients 
only so this rule will be ignored for other clients 

• "Create the following non-recurrent project upon task failure" - allows you to create a new non-recurrent project 
automatically in case the task of this task template is failed. There's also an option to close this project if the task 
was failed and a new project was created. 

• "Prompt to attach file document upon task completion as the result of task work" - allows you to notify employee that 
the file must be loaded in the database after the task completion 

• "Prompt to review the client invoice upon task completion as the result of billable work" - opens "Edit Invoice" form 
after the task is completed 

• "Prompt to enter work time upon completion of this task" - opens "Add new work time for task" window automatically 
upon the task is completed. 

• "Prompt to enter quick note when closing this task" - opens a quick note window after the task is completed to ask 
employee to leave a note regarding completed task 

 
In "Default Task Instructions" tab you can add general instructions for this task. Please note, modifying instructions 
you can easily copy task name to it using an appropriate button: 
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"Problem triggers" tab contains all problem triggers linked to this task template. You can add new problem trigger by 
clicking "New Problem Trigger" button. Please refer to "How to manage problem triggers" topic of this guide to get 
familiar with problem triggers management. The main idea is when certain task of the project becomes active the pre-
defined problem will be triggered. The problem must be solved before you can complete the task. 
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"Completion Email Template" tab allows you to automatically send email to the client upon the task is completed. To 
automatically specify task's details you can use macros in the subject and body of the email. You can find macros 
available for this template in Appendix A of this guide. Outgoing email for the template can be set in "Office 
settings">>"Email Templates" window. 
 
Tip: "Use global outgoing email to send task completion notifications. This will allow application to 
send notifications for reoccurred projects' tasks automatically." 
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Working with tasks and projects grids 
 
Tasks and projects grids contain many columns available to view. Usually not all of them are useful for user. To view 
all available columns click on the asterisk in the left top corner of the table: 
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Some of these columns consolidate information from other columns to make your work with the application easier. 
"Consolidated Client Name" field consolidates "Company" and "Primary Taxpayer" fields. "Project template >> 
task template" field consolidates project template and task template fields. Both fields are visible by default. 
 
"Project Owner | Task Owner" field consolidates project owner and owner of the task if it's not the same person. 
"Primary Taxpayer / Partner 1" field consolidates clients first name and last name. "Spouse / Partner 2" field 
consolidates spouse's first name and last name. Another one field is "Full address" which consolidates client's 
address, city, state and zip. "Project + Task Instructions" and "Task + Project Instructions" fields consolidate 
instructions in certain order. All these fields are not displayed by default but you can easily make them visible by 
checking certain boxes. 
 
If you work with tasks of some user or with your own tasks you can find a "Priority" column among other. If you can't 
see it add it as it was described above. 
 

 
 
Here you can change the priority of tasks. Sort them by priority and than simply drag-n-drop the task according to its 
new priority. 
 
Also, you can click "Reprioritize Tasks" button at the top of the tab and accept the reprioritization of tasks in the order 
they are displayed in your view. 
 
Built-in filters allow you to change grid in several clicks according your needs. Most filters are understandable easily. 
Below is an explanation of how some of "Project Status" filters work: 
• Next occurrence - this filter shows projects that has not occurred yet and will occur in future 
• Last occurrence - this filter shows last projects that occurred (including stopped projects that will not reoccur again in 

future) 
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To save your grid to use it in future you can save it as a report. Read more about reports in "Reports Management" 
chapter. 
 
 
 
 
 

7. Problems Management 
 

In this chapter you can find out what problems are, how they work and how to manage them. 
 
 
What are problems? 
 
Problems stop the processing of a project if a certain condition is met. When a problem is created, nobody can 
upgrade the project until the problem is solved. There are two problem scopes: client-related and staff-related. For 
example, if you have a task to be done but your client didn’t send you the required bank information, you can create a 
problem that the task cannot be completed until this information is received from the client. This helps to avoid several 
of management issues: 
 You guarantee that nobody will accidentally upgrade the project and proceed with incomplete data, which can 

cost you your reputation and future business 
 You can quickly oversee what is stopping your staff from working on their customer returns  
 You can quickly send template-driven instructions to customers notifying them of what you require them to do 

before you can complete the draft return 
 You can follow up with reminders in case the customer fails to follow up in a reasonable time frame 
 

 
 
How problems work 
 
When you create a problem on a task, you can’t complete it until the problem is solved. Below are examples of tasks 
with and without problems. 
 
Task with problem (the “Complete” button is disabled): 
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Task without problem: 
 

 
 
In order to solve a problem, select the "View problems" button on the Edit Task or View Tasks forms. The list of 
problems will appear: 
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From this list, you can review task problems, email a reminder or solve problems. 
 
To create a problem select the task or project and click "Create problem" button. 
 
All available problems are shown in the list, all you have to do is to select one and to create it by clicking a "Create 
problem" button on the top of the form. If you need to create multiple problems click "Select Multiple Problems" button 
and check problems that you need to be created. You can also create a problem with a custom info by double-click of 
the left mouse button or by clicking a right mouse button and selecting "Create problem with customized instructions" 
from the drop-down menu: 
 

 
 
Here's a form that you can edit choosing to create problem with a custom info: 
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By raising the problem, you will effectively put a road block on the further execution of the project until you receive the 
missing information from the client.  
 
You can also automatically create problems based on the workflow rules. See the problem triggers section for more 
information about how accomplish this. 
 
To view currently open problems for all tasks in the system, select “Workflow"> "View problems” or press F9: 
 

 
 
From this list, you can drill down to the project and task that triggered problems, as well as email reminders. 
 
In the "View problems" window you can apply the following filters: 
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To save your grid to use it in future you can save it as a report. Read more about reports in "Reports Management" 
chapter. 
 
How to manage problems 
 
Since you can add many project problems that can happen throughout the business, it's a good idea to organize them 
into categories to quickly navigate to the problem that suits your situation. You will need to create many problems 
because each time a problem occurs it can require special instructions or requirements that can be detailed in the 
problem instance to make sure that it can be resolved quickly.  
 
You can manage problem categories going to “Administration"> "View problem categories”.  
 
Here you can add, edit, delete problem categories. 
 

 
 
The problem templates will be classified into these categories so they can be located more easily. To manage the 
problem templates, select “Administration”> “View problem templates”. 
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Here you can add, edit, delete problem templates. Also from here you can easily create a new problem category or 
manage the list of them by clicking "View Problem Categories" button. Click "View Problems" if you want to see all 
created and solved problems based on this template. "View Problem Triggers" button allows you to see all problem 
triggers that create problem based on this template. 
 
Please note: deleting problem category or problem template will force to delete all corresponding problems. If a 
problem trigger creates some problem you will not be able to delete this problem or its template or group until the 
problem trigger is deleted. 
 
Below is a form to add a new problem template which includes “Problem category” list, “Problem name”, "Problem 
scope" and “Instruction” fields: 
 



174 

 

 
 
The "Instruction" will be automatically pre-populated when you create a problem based on this template. 
 
Tip: "Use project and task-related macros to specify the task, project, it's period and deadline in 
the instruction of the problem. Later this information will be shown in the email template that 
contains #EXCEPTIONS# macros:" 
 

 
 
If you select “Problem scope” as Client-related, these instructions will be emailed to your client when the problem is 
created. Alternatively, Staff-related problems are not emailed to clients and refer only to the internal processing 
workflow that do not require communications with the client. 
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Create problem wizard 
 
Wizard for problem creation is another way to create a problem for a certain task. You can open this wizard from 
"View Projects", "View Tasks" or "View Clients" windows by clicking "Create Problem": 
 

 
 
If you click "Create Problem" button from the "View Clients" window you will see the list of all open tasks assigned to 
this client. When the task is selected click "Next" button and select problem templates from the list: 
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Next you will see default problem solution that can be changed: 
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The next window shows the selected problem template and its solution and allows you to change client and/or task 
you are creating problem for: 
 

 
 
Upon clicking "Next" button the problem will be created: 
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Click "OK" button to close the wizard. "Edit email" window will be opened automatically. It will contain the information 
regarding problems created for particular user:  
 

 
 
Click "Preview" button to see the message with macros replaced with real data: 
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8. Problem Triggers Management 
 

In this chapter you can find out what problem triggers are, how they work and how to manage them. 
 
 
What are problem triggers? 
 
Problem triggers creates problems automatically. When using them you don’t need to create problems manually every 
time they happen. Problem triggers will create problems if certain conditions are met for each project in your system. 
This provides repetitive, consistent tracking of hundreds of things that can possibly go wrong or get lost in the 
processing of a tax return. 
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How problem triggers work 
 
Problem triggers are simple IF-THEN rules that work the following way: when a certain project achieves a pre-defined 
task/step and certain other criteria are met, the problem is created automatically and the project is blocked from 
progressing until the problem is solved.  
 
Tip: "Since some of your customers have both business returns and personal returns prepared by 
you, you can set the system to automatically trigger a problem to make sure you will never miss 
importing K-1 into the personal tax return using the following rule:" 
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How to manage problem triggers 
 
To edit problem triggers categories go to “Administration”-> “View problem triggers…”. 
 
You will be able to create a new problem trigger and select an existing problem trigger from the list to edit, duplicate, 
delete, or run it. Right mouse button click allows you to select an option to refresh the list of problem triggers. 
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In this form, you can add, modify, or delete a problem trigger. You can also duplicate problem trigger, i.e. copy its logic 
if you want to create a few special cases for several individual clients (i.e. child support). 
 
Please note that once enabled, the problem trigger will always trigger problems on all new tasks. In order to create 
problems that meet the conditions described by the problem trigger for already opened tasks, i.e. after the new 
problem trigger was created or modified, you may want to “Run selected problem trigger”. This will create all problems 
on existing open tasks that can match your new problem trigger criteria.  
 
This problem trigger will keep running until you disable it or it expires. 
 
 
 
 
 
 
Create problem trigger wizard 
 
New problem trigger creation consists of several steps assembled to a user-friendly wizard. On the first step you can 
select a client to assign this problem trigger to: 
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You can skip this step by clicking "Next" button. This will mean that the problem trigger will be created for all clients. 
 
Next you need to select a problem template for the problem trigger: 
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Click "Next" and on the next screen select a project template to assign problem trigger to: 
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The next step is to select a task of the project on which the problem will be triggered: 
 

 
 
The last step allows to select: 
• problem trigger name 
• time to live (if you want the problem trigger to be permanent or expire after selected tax year) 
• account type and return type if necessary 
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Click "Next" button and "OK" if the problem trigger creation process was finished without any issue: 
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9. Billing/Invoicing Module 
 

Work with bills and invoices is completely described in this chapter. Here you can find out how to create and edit 
invoices, add new items to your invoices. How to work with services invoice wizard is also described in this topic. 
 
 
Working with accounts 
 
Starting your work with TaxWorkFlow's invoicing system you need to add accounts you want to include in invoices. 
There are a number of accounts grouped by type available by default. To browse existing accounts, to modify, to 
delete them or to add new accounts you need to go to “Billing”-> “View accounts...” 
 

 
 
To edit an existing account double-click on it or select it and click an "Edit Selected Account" button: 
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In this window you can change account's type, name, office it's assigned to and its rate. Also you can choose if this 
account invoiceable and edit billing description for this account. "Save And New" button allows you to save changes in 
current account and immediately create a new one. To add a new account from the "Edit Accounts" window you need 
to click on "Create New Account" button: 
 

 
 
Select a type of the new account from drop-down menu, add name and rate of it and determine if it's invoiceable or 
not. Add billing description if necessary. Save the changes you've done and a new account will appear in the list of 
accounts. 
 
Accounts of "Work time" type have a billing category: 
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You can manage billing categories by clicking "Billing">>"View billing categories": 
 

 
 
Here you can add new category, delete existing categories or change their names and/or billing status. The most 
common way of using billing categories is analysis of the time spent for some work. For example, you can add such 
categories as  Accounting, Correspondence, Reconciliation, Tax Forms etc. Apply certain category to the time you are 
adding to invoice and later you can see how much time and money was spent for accounting, work with 
correspondence etc. 
 
Operations with invoices 
 
When accounts are set you can start to create invoices. For this purpose go to “Billing”-> “Create invoice...”: 
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In this window first you need to select a client and an office which serves this client. You can also add some memos to 
the invoice. When these steps are completed you need to add items into it. Click "New Invoice Item" button: 
 

 
 
Select a necessary account to add, modify rate, quantity and the date when it was serviced if you need to. You can 
also enter a week, month or quarter of selected tax year. Add billing description (will be shown on the invoice) and 
comments (will not be shown on the invoice, for internal use only) if you have some.  
 
"Create Account" and "Edit Account" buttons allow you to open appropriate windows from here and make necessary 
changes. After all fields are filled you can simply add another item to the invoice clicking "Save and New" button. 
"Save and Close" button will add the item to the invoice and close the window while "Save" button will save the data 
and leave the window opened.  
 
To enable all invoice operations you need to save a draft invoice. Upon it's saved you can still add new items to the 
invoice, edit, merge and delete existing items. Among the others invoice items you can add: 



191 

 

 
• Work Time Item - opens a list of billable work time for the client from where you can select what time to include to 

the invoice 

 
 
• Invoice Credit Item - allows to apply an invoice credit 

 
 
• Apply Referral Credit - allows to apply referral credit to the invoice (see more in Referrals chapter of this guide) 
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Also the following buttons are available upon invoice saving: 
 
• Issue invoice - changes invoice status to "Final invoice". You can reverse the invoice back to draft invoice by clicking 

an appropriate button later. 
• Pay invoice - opens "Receive New Payment" window (see more information about Payments) 
• Cancel invoice - changes invoice status to "Cancelled" 
• Change invoice date - allows to change invoice date (available for invoices with a status of "Final invoice") 
• Delete invoice - deletes currently opened invoice 
• New note - allows to add notes to this invoice 
• Add file - allows to attach files to the invoice 
• Sync with QuickBooks - syncs the invoice with QuickBooks 
• Export - exports file to Excel or PDF document 
• Email - opens "Invoice attachment email template" in email editor with attached XLSX or PDF file and prepopulated 

client's email address  
• Save to docs - opens "Edit document properties" window (see Uploading documents chapter) 
• Print preview - allows to preview the document and design and format it before printing. See detailed description of 

this option in "Invoice print preview" chapter 
• Print - opens a print dialog 
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You can manage all created invoices from one place. Go to “Billing”-> “View invoices...”: 
 

 
 
Most operations available in "Edit Invoice" window are available there too. Also from here you can duplicate invoice 
(create a new draft invoice which is a copy of selected invoice. For example, this could be useful if you need to create 
similar invoices for different clients) and work with multiple invoices at once. 
 
"Select Multiple Invoices" button allows you to delete, export to Excel or PDF and email selected invoices 
independently of their status. If statuses of all selected invoices allow the operation you can issue, pay, cancel 
invoices, reverse them to draft invoices. 
 
Previously deleted invoices could be shown by clicking "Show Deleted Only" button. Please find out how to work with 
Reports in the "Reports management" chapter. "Filters" button allows you to customize the invoices displayed in the 
grid. Below is a list of all available filters with their description: 
 
Filters group Filter name Description Period, assuming today is Wednesday, April, 5, 

2017 
Invoice status All invoice statuses All invoice statuses  
 Draft invoice Draft invoice  
 Final invoice Final invoice  
 Paid in part Invoices paid in part  
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 Paid in full Invoices paid in full  
 Cancelled Cancelled invoices  
    
Issuing office All offices Issued by all offices  
 "Your office name" Issued by "Your office name"   
 etc A list of all offices of your company  
    
Invoices for 
period 

All history No time period applied All invoices displayed 

 Today Today only All invoices created on April 5, 2017 
 Yesterday Yesterday only All invoices created on April 4, 2017 
 This calendar week-to-date From Sunday of the current week through today All invoices created in the date range from April 2, 

2017 till April 5, 2017 
 This calendar month-to-date From the first day of the current month through 

today 
All invoices created in the date range from April 1, 
2017 till April 5, 2017 

 This calendar quarter-to-date From the first day of the current quarter through 
today 

All invoices created in the date range from April 1, 
2017 till April 5, 2017 

 This calendar year-to-last-
month 

From the first day of the current year through the 
last day of last month 

All invoices created in the date range from January 
1, 2017 till March 31, 2017 

 This calendar year-to-date From the first day of the current year through 
today 

All invoices created in the date range from January 
1, 2017 till April 5, 2017 

 Since one week ago All dates since one week ago All invoices created in the date range from March 29, 
2017 till April 5, 2017 

 Since one month ago All dates since one month ago All invoices created in the date range from March 5, 
2017 till April 5, 2017 

 Since one quarter ago All dates since one quarter ago All invoices created in the date range from January 
5, 2017 till April 5, 2017 

 Since one year ago All dates since one year ago All invoices created in the date range from April 5, 
2016 till April 5, 2017 

 Past calendar week Sunday through Saturday of past week All invoices created in the date range from March 26, 
2017 till April 1, 2017 

 Past calendar week-to-date From Sunday of past week through today All invoices created in the date range from March 26, 
2017 till April 5, 2017 

 Past calendar month From the first day through the last day of past 
month 

All invoices created in the date range from March 1, 
2017 till March 31, 2017 

 Past calendar month-to-date From the first day of past month through today All invoices created in the date range from March 1, 
2017 till April 5, 2017 

 Past calendar quarter From the first day through the last day of past 
quarter 

All invoices created in the date range from January 
1, 2017 till March 31, 2017 

 Past calendar quarter-to-date From the first day of past quarter through today All invoices created in the date range from January 
1, 2017 till April 5, 2017 

 Past calendar year From the first day through the last day of past 
year 

All invoices created in the date range from January 
1, 2016 till December 31, 2016 

 Past calendar year-to-date From the first day of past year through today All invoices created in the date range from January 
1, 2016 till April 5, 2017 

 Before... All dates before the date you specify All invoices created in the date range from date you 
specify till April 5, 2017 

 After... All dates after the date you specify  
 Custom range... The date range you specify  
 
 
Services invoice wizard 
 
TaxWorkFlow's services invoice wizard allows you to create invoices quickly and easily. Before you open the wizard 
for the first time you need to setup prices for services you provide. Go to “Billing”-> “View accounts...” where you can 
determine all services prices. Here is more information how to do it. 
 
After all prices are set you can use a wizard. Please go to “Billing”-> “Services invoice wizard...” 
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Here you need to select a client and an office which is serving him/her. You can also select a tax year. Then you can 
select any services to be included in the invoice and add your comments. When the invoice is ready click "Save" 
button and this invoice will appear in the "View Invoices" window with "Draft Invoice" status. To modify this invoice you 
may open it in editor clicking appropriate button in the "Services invoice wizard" window or you can go to “Billing”-> 
“View invoices...”. Work with this window is completely described in "Operations with invoices" section of this chapter. 
 
Invoice print preview 
 
Print preview option is available for all invoices in the system. It could be opened from "View Invoice" window and it 
looks the following way: 
 

 
 
This window contains several groups of buttons. 
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"Report" group - these buttons allow user to load, unload and save Report File (*.rps). Design button allows you to 
make changes in invoice design while Rebuild button rebuilds the preview according to submitted changes. 
 
Design button opens a popup window where you can change format report options, colors, fonts and behaviors: 
 

 
 
Also from here you can setup format's title and/or footnote text and properties. 
 
"Output" group of buttons allows you to send the document to your default printer by clicking "Print" button. "Print 
dialog" button opens a standard Windows dialog where you can select printer and setup printing properties."Export to 
PDF" button opens "PDF Export Options" window. 
 
"Format" group contains the following buttons: 
Page Setup - opens "Page Setup" window where you can setup  
 paper size 
 paper source 
 orientation 
 print order 
 shading 
 margins 
 header/footer 
 scaling 

Format button allows to edit title, footnotes, page numbering and date and time format. 
Background button allows you to select a background color and fill effects. 
Fit to Page Width - allows you to set content to page width. 
 
"Zoom" group buttons allow you to select a preferable zoom of the preview: 
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"Navigation" group of buttons allow you to navigate the pages of the invoice. 
 
"Preview" group contains "Thumbnails" button that enables thumbnails, "View" button that allows you to show/hide 
margins, margins bar and status bar. "Header and Footer" button unhides header and footer tabs where you can 
select a part of header/footer and insert the following information there: 
 Page number 
 Number of pages 
 Page number of pages 
 Date and time 
 Date 
 Time 
 Machine name 
 user name 

 

 
 
 
 
 
Payments 
 
Payments system allows you to control the payment status of the invoices. When payment is received you need to 
reflect it in the system. You can do it using one of the following ways: 
 
1. Click "Pay Invoice" button from "View Invoice" or from "View Invoices" window. "Receive New Payment" window will 
be opened with prepopulated data from the invoice you are going to pay: 
 



198 

 

 
 
Here you can select or change the client and the office, edit date of payment, add its reference number, select 
payment type. Select invoice(s) you would like to pay, edit payment fee and net received amount. 
 
Tip: "If you select some invoice from the list "Gross paid amount" will be changed to invoice's total 
amount. You can add payment fee and this will decrease net received amount automatically. In 
case you enter net received amount and fee manually it will change gross paid amount 
automatically independently of total amount of the selected invoice. So manually entered numbers 
always have higher priority for the system." 
 
Please note, the status of invoice will be changed to "Paid in part" if the paid amount is less than a total amount and to 
"Paid in full" if the paid amount is equal to the total amount. When all the fields are filled correctly click "Save" button. 
Upon saving notes and files could be attached to the payment. 
 
2. Go to "Billing"->"Receive New Payment". This menu item will open the same window that is described above but no 
fields will be prepopulated. You will need to select the invoice from the list of invoices. This list could be decreased 
upon you specify an office and a client in appropriate fields When the invoice is selected all the operations described 
in the previous point are available. 
 
3. Click on "Billing"->"View Payments" menu item and click "Receive New Payment" button in the top left corner of the 
form. This will open "Receive New Payment" window described above. 
 
Tip: "If a gross payment exceed the invoice amount the system will allow you to select if you want 
to create a deposit based on overpaid amount or refund the difference" 
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Tip: "If you select a deposit as a payment type you could choose one deposit from the drop down 
list. In case the total invoice amount is less than deposit amount, the deposit balance will be 
updated (decreased). Also you can select "Refund" option that will mark deposit as "Withdrawn in 
full". If the total invoice amount is greater than deposit amount the deposit amount will be marked 
as "Withdrawn in full" and the invoice status will be changed to "Paid in part". 
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"View Payments" window contains a list of received payments: 
 

 
 
Besides receiving of a new payment from here you can view payment, void payment or delete it. Please note, when 
you void the payment the invoice paid by this payment becomes non-paid. 
 
"Select Multiple Payments" button allows you to void or delete multiple payments at a time."Show Deleted Only" 
button allows you to see a list of previously deleted payments. 
 
Tip: "You can see detailed statistics by changing grid view. For example, if you need to see the 
total net payment amount of each client, group the data by "Client (Payer)" and the total amount 
will be available at the bottom of each group (see image below)" 
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Deposits 
 
Deposits in TaxWorkFlow can be managed from "View Deposits" window: 
 

 
 
There are several ways to create a new deposit: 
 
1. Click "Add New Deposit" button from "View Deposits" window. Select client and office and enter deposit amount in 
the appropriate field of the form or by clicking "Add Deposit Amount" button. Deposit date could be changed if needed: 
 

 
 
2. New deposit can be automatically created when the invoice is overpaid if you select this option. Another option is to 
refund overpaid amount: 
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When the deposit is saved you can notes and documents to it. Also the following operations are available: 
 
Add Deposit Amount allows you to add any amount to the deposit. 
 
Refund Balance allows to refund remaining balance to the client. The status of the deposit will change to "Refunded 
in Full" if this deposit wasn't used in payments. If the deposit's status was "Withdrawn in part" the status will stay the 
same and the balance will be set to zero. 
 
Write Off Balance allows to write off remaining balance. The status of the deposit will change to "Written Off in Full" if 
this deposit wasn't used in payments. If the deposit's status was "Withdrawn in part" the status will stay the same and 
the balance will be set to zero. 
 
Refund Entire Deposit will change the status of deposit to "Refunded in Full" and set balance to zero. If the deposit 
was used in payments you can adjust payment and invoice records or leave them as is using the following dialog:  
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Delete Deposit allows you to permanently delete deposit from the system. If the deposit was used in payments you 
can adjust payment and invoice records or leave them as is using the dialog above. 
 

 
 
Please note, if the deposit was already used and its status is "Withdrawn in Part" you can not decrease its amount. 
 
 
 
 
 

10. Time Tracking 
 

TaxWorkFlow includes a Time Tracking module. This chapter describes all features of it. 
 
 
Work time tracking 
 
To track your time working on some task you need to use a group of Time Tracking buttons in the toolbar. 
 

 
 
Click "Begin Work" to start time tracking and "End Work" to stop it. You can also add working time manually. Select 
the task in the grid or open the task by clicking on it and then click "Add Work Time" button. 
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In this window you can select a user for whom you want to enter a work time. You can fill in a duration field or change 
start and end work time and date. Also you can check a billing status as "Billable". The status must be changed to 
"Billable" if you add the work time to invoice by clicking an appropriate button on the top of the form. Please note, you 
need to save the work time by clicking "Save" button to be able to add it to invoice. 
 
Duration field supports different formats of data. Below is a table of symbols that you can enter in this field: 
 

Time period Possible symbols 
Year(s) y year years  
Month(s) m month months  
Week(s) w week weeks  
Day(s) d day days  
Hour(s) (<24) h hr hour hours 
Minute(s) (<60) m min minute minutes 
Second(s) (<60) s sec second seconds 
 
Let's look at some examples of how you can enter work time duration: 
 
•  1 year 2 months 2 w 4 d 7hr 18 m 50 sec 
•  8 hour 34 min 
•  50 m (will be counted as 50 minutes) 
 
Tip: "You can use symbol "m" to enter months and minutes but if "m" occurs just once in the string 
it will be counted as minutes" 
 
Other formats to enter work time duration are HH:MM (eg 14:20 that would be counted as 14 hours and 20 minutes) 
and HH.X (eg 9.5 that would be counted as 9 hours and 30 minutes). 
 
Please note, you can't mix formats in one string. For example, 2 days 12.5 won't work. 
 
Clicking "Add To Invoice" button will open a "Select Invoice" window. It shows all the invoices related to work time for 
this client. You can select an existing invoice or create a blank invoice to add a work time to it. 
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When the invoice is selected you can add a new invoice item to it: 
 

 
 
Select an invoiceable account from the drop-down list or create a new account. Also you can edit accounts from the 
list by clicking "Edit Account" button. Below is an example of "Edit Account" window: 
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Upon the work time is added to the invoice it can not be edited. You can only delete work time or edit the draft invoice 
where it was added to. 
 

 
 
Work with invoices is completely described in Billing/Invoicing Module chapter. 
 
View user work time 
 
To view a work time added by the users of the system you need to go to “Billing”-> “View user work time...” 
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In this form you can edit work time items and delete them. Also you can edit related tasks from here. A set of filtering 
options allows you to output the information the way you need it. This information can be exported to the format you 
wish. "Select Multiple Work Time" button allows you to add multiple work time items to the invoice or delete these 
work times. 
 
Tip: "You can see detailed statistics by changing grid view. For example, if you need to see the 
total amount of hours that were already billed, group the data by "Billing Status" and look at the 
total amount of hours (see image below)" 
 

 
 
 
 
 
 

11. Email and Calendar 
 

In this chapter you will find out how to sync your existing email service and calendar with TaxWorkFlow. 
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Email client 
 
TaxWorkFlow contains a built-in email client to allow you to work with your correspondence straight from the 
application. You can learn how to sync your existing email account with TaxWorkFlow at "Office settings" chapter. 
"Email sync troubleshooting" chapter will help you to address syncing issues. 
 
To open email client go to Dashboard and click on the "Emails" tab. 
 

 
 
Above you can find a list of emails synced with TaxWorkFlow.  
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"Client Emails" group contains all messages linked to different clients. Select the client from the list and you will see all 
correspondence related to him and his associates.  
"Staff Emails" group contains messages to your staff members.  
"Clutter Emails" folder contains those emails that are not linked to any client or staff member. 
"Outgoing Emails" folder contains those emails that were sent by you or by the system automatically. If the email was 
sent successfully it will be removed from the folder. If the email was not sent during one hour due to some reasons (ie 
incorrect outgoing email settings) it will be moved to "Unsent Emails" folder. 
"Unsent Emails" folder contains those emails that were not sent by the application due to some reasons. Each hour 
the server will attempt to send emails from this folder. If the attempt is successful the email will be removed from the 
folder. Emails that must be delivered next business day are also stored in "Unsent Emails" folder. 
 

Tip: "Use search bar and filters to find the message you need." 
 
Please note, you can also find all messages related to certain client at the "Emails" tab of the "Edit Client" form. 
 
From the Dashboard you can create new emails by clicking "New Email" button. Upon clicking "New Email" button 
"Edit Email" window will appear: 
 

 
 
Here before sending a message you can test your outgoing email account, preview message and attach files to it. 
Click "Deliver Next Business Day" to postpone the delivery to 9am of the next business day. Use "Select User" and 
"Select Client" forms to find the recipient quicker. 
 
Also the following actions are available from the Dashboard: 
 

 
• Email to client - when client's email subfolder is selected this button allows you to email this client and/or his 

partner/spouse. Select a person you would like to email and a template from the list and the "Edit Email" window will 
appear 

• Open email - opens selected email in the "View Email" window 
• Edit  email - allows to edit email and send it again 
• Reply - allows to reply to sender 
• Reply all - allows to reply to all recepients of the message 
• Forward - allows to forward the message 
• Assign email to a client - links email with the client. Relation with current client remains 
• Assign email to a project - assigns email to an existing project 
• Assign email to a task - assigns email to an existing task 
• Assign email to another client - links email with another client. Relation with current client terminates. 
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• Unlink email - allows you to remove link of the message to the client or employee. This message will be placed in 
"Unlinked" group 

• Delete email - deletes email 
• Create project based on this email - creates a new project of selected type with selected email attached to it 
• Create task based on this email - creates a new task with selected email attached to it 
• Create problem based on this email - allows to create a problem for any task opened for the client. If the email is not 

linked to any client you can create problem for any task that is not linked to any client, too 
• Solve problem based on this email - solves a problem based on this email if it was previously created 
• Edit project - opens "Edit project" window if this email was already assigned to the project 
• Edit task - opens "Edit task" window if this email was already assigned to the task 
• Edit problem - opens "Edit problem" window if it was already created based on this email. 
 
Calendar 
 
Calendar in TaxWorkFlow allows you to manage your meetings and other events straight from the application. You 
can learn how to sync your existing calendar with TaxWorkFlow at "Office settings" chapter. 
 
To open calendar go to Dashboard and click on the "Calendar" tab. The list of calendars will be shown at the top left 
corner of the window: 
 

 
 
 
Using "Day View", "Work View", "Week View", "Month View" and "Timeline View" buttons you can change the view of 
the calendars according your needs.  
"Compress Weekend" button unites Saturday and Sunday into one column for a "Month View". 
"Working Hours" button shows only working hours in "Day View" or "Work Week View". Also for these two views you 
can change a time scale by clicking an appropriate button and selecting values from 5 to 60 minutes. 
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"Group by None" button will show you events of all calendars at the same screen while "Group by Calendar" button 
allows you to see all calendars separately on the screen: 
 

 
 
To add a new event click "New Appointment" button or double click on the place of the calendar where you want a 
new event to appear. The application will open "Edit Event" window or ask you to select a calendar where a new event 
must be posted in case you have more than one calendar: 
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Next double-click on the calendar or press a "Select" button. In the "Edit Event" window enter the subject of the event, 
its location (if necessary), start and end time (use "Show Time Zones" button to select a timezone). Check "All day 
event" box if necessary. Add message to the appropriate field: 
 

 
 
Click "Recurrence" button if you need this event reoccur. To set up recurrence first enter the start and end time of the 
event: 
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Then select recurrence pattern from 4 available - Daily, Weekly, Monthly or Yearly. 
 
For daily recurrence you can set up the event to reoccur every weekday or every 1st, 2nd, 3rd etc day. 
 
For weekly recurrence select the day of the week the event must recur and determine the number of weeks between 
events: 
 

 
 
For monthly recurrence you can set the event to recur on the certain day of every 1, 2, 3 etc months or you can set it 
up to recur on the certain weekday every 1, 2, 3 etc months: 
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Yearly recurrence allows you to set up the event to recur on the certain day/weekday of the certain month: 
 

 
 
The last thing you need to set up in this window is "Range of recurrence". 
Determine a start date and select when the event must stop to recur if necessary. Here you can select a certain date 
or the number of occurrences before it stops to recur. 
 
To stop recurrence manually simply click "Remove recurrence" button. 
 
All parameters you set for the event can be edited later. Just double-click on the event to edit it and select if you want 
to edit this particular event or the series of events. Another way is to select the event by mouse click and click "Edit" 
button. To open an event you can also click right-mouse button and select "Open" from the appeared menu: 
 



215 

 

 
 
Please note, clicking "Edit" Series" will allow you to edit the recurrency. 
 
From here you can also change "Label" colors or you can delete the event. 
 
Please note, you can drag-n-drop the event if its time and/or date need to be changed. 
 
 
 
 
 

12. Dashboard 
 

Dashboard was created to simplify your workflow. You can find all necessary tools in one place and user-friendly 
interface will make your work with TaxWorkFlow as easy as it could be.  
 
You can work with Clients straight from Dashboard. You can also work with tasks, projects and problems from here. If 
you need to change columns of the grid, click on the asterisk in the left top corner of the table. 
 
All available operations with clients were described in Client Management section of this guide. Working with tasks 
and projects is completely described in Projects and Tasks Management chapter. Problems Management chapter 
contains the full information about problems. Emails and Calendar are described in the appropriate chapter. 
 
"Shortcuts" window is a kind of a map of the application. Here you can find all main modules of TaxWorkFlow and see 
how they are linked with each other and their main functionality. The first tab is a "Workflow" tab: 
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Clients, Documents, Workflow and Time & Billing modules of TaxWorkFlow are displayed there. Most popular 
shortcuts from this modules are added to the scheme. Each user of the system may work from here comfortably. 
 
The second tab is an "Administration" tab: 
 

 
 
From here you can manage connections and users of the system. Also an "Administration" module with the most used 
functionality is represented here. 
 
To see your permissions in this tab you can click a "View Permissions" button: 
 

 
 
Below is an example of the "View Permissions" window: 
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13. Interaction with QuickBooks 
 

This chapter contains the information about TaxWorkFlow interaction with QuickBooks. 
 
 
Authorization dialog 
 
The first time TaxWorkFlow logs in to QuickBooks, QuickBooks must already be launched and running in the 
foreground with a company file open and the administrator user logged in. These requirements prevent unauthorized 
applications from gaining access to QuickBooks. 
 
The authorization dialog appears when TaxWorkFlow tries to access a QuickBooks company file for the first time. The 
authorization dialog is also displayed when 

• A QuickBooks company file is opened for the first time by TaxWorkFlow after it makes an event subscription. 
• TaxWorkFlow previously authorized to access a particular QuickBooks company file attempts to access that file 

in a way different than authorized or with different preferences than the last time it accessed that file. 
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Here is an example of QuickBooks default authorization dialog: 
 

 
 
Below is the list of dialog's available options and their explanations:  

• No - refuse authorization. 
• Yes, prompt each time - authorize for only the current session and force the application to be authorized again 

the next time the application attempts to access a company file.  
• Yes, whenever this QuickBooks company file is open - authorize the application to access QuickBooks with no 

additional authorization whenever that company file is open, regardless of which user is logged in. 
• Yes, always; allow access even if QuickBooks is not running - authorize the application to log on in unattended 

mode (auto login). 
 
If the user selects unattended mode authorization, and if there is more than one user (not just the administrative 
user) then the “login as” dropdown is visible and enabled, presenting the user with a list of login IDs currently able 
to log in to that company file. 
 
The checkbox at the bottom of the authorization dialog, if checked, authorizes your application to access sensitive 
personal data. However, the currently logged in user is still restricted by the permissions set up in QuickBooks, 
regardless of whether or not the checkbox is checked. 

 
Setting authorization preferences within QuickBooks 
 
The QuickBooks administrator may need to set additional authorization preferences or change existing authorization 
preferences for integrated applications within QuickBooks by clicking on the Integrated Applications icon in the 
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QuickBooks Preferences window, then selecting Company Preferences. Preferences that can be set by the 
administrator include the following: 
 

• Disallowing or changing application access. 
• Enabling certificate date checking. 
• Listing authorized applications. 
• Granting auto-login privileges and assigning the name of the auto-login user. 
• Allowing application access to personal company data. 

 
The screenshot below shows the window presented to the administrator for managing integrated applications and their 
access to QuickBooks. 
 

 
 
Import clients from QuickBooks 
 
TaxWorkFlow can automatically upload clients from QuickBooks using a predefined template. Before importing make 
sure QuickBooks application and QBFC13.0 are installed on your PC. If your first installation was TaxWorkFlow 
2.0.0.41210 or later version, QBFC13.0 is already included to the package you've installed otherwise you need to 
download QBFC13.0 from http://thetaxworkflow.com/release/QBFC13_0Installer.exe and install it separately. 
 
Select “Clients>Import clients from QuickBooks”: 
 

http://thetaxworkflow.com/release/QBFC13_0Installer.exe
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Here you can select from where you want to import clients: directly from QuickBooks account or from QuickBooks 
company file (*.qbw). If you want to import clients directly from QuickBooks make sure your QuickBooks application is 
running on your PC. If you want to import clients from company file, please note, that your QuickBooks application 
must be closed before the importing procedure. 
 
The next steps are to map fields that were not mapped automatically and to validate values of cells. Both procedures 
are identical to Import clients from Excel. After it's done you can start import clicking the appropriate button. 
 
Export invoices to QuickBooks 
 
To export invoice to Quickbooks first open it in "Edit Invoice" window. To start the process click "Export" button and 
select "Export to Quickbooks" option. Then follow the instructions in the appeared window: 
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After the software components and company file check, the system will check if this invoice was already exported to 
QuickBooks. 
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When existing of all elements of exported invoice confirmed and there's no such invoice in QuickBooks the system will 
compare the client's information stored in both systems: 
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If there's a difference you can select where the information must be updated. Step 2A confirms that all data in both 
systems is matching and allows you to finish export. 
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If the invoice exists in QuickBooks you'll see the following window with a number of options: 
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If you select to modify information on the previous step you will see the comparison of stored invoices: 
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If no information found in QuickBooks application the invoice will be exported as is from TaxWorkFlow. 
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QuickBooks connection troubleshooting 
 
Make sure QuickBooks application is installed on your PC. 
 
If you have the error like this one: 
 

 
 
1. Check if QBFC13.0 is installed on your PC.  
2. If QBFC13.0 is not installed please install it from http://thetaxworkflow.com/release/QBFC13_0Installer.exe or from 
TaxWorkFlow application folder. 
3. Restart TaxWorkFlow after QBFC13.0 installation is complete. 
4. If you're sure that QuickBooks application and QBFC13.0 are installed and you still get the error then restart 
QuickBooks application and TaxWorkFlow. 
 

http://thetaxworkflow.com/release/QBFC13_0Installer.exe
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14. Client Portal 
 

Client Portal is a web-portal (usually created as a sub-domain of your web-site) where your clients can securely 
upload their documents to the TaxWorkFlow database. Please contact TaxWorkFlow support team if you want a portal 
to be created for your company. When the portal is ready and uploaded you need to set it up from TaxWorkFlow. Go 
to "Administration" >> "Office Settings" and select "Client Portal" tab. Enable portal from here, add a Client Portal URL 
and select a folder where all the document will be uploaded: 
 

 
 
"Notify these recipient(s)" field contains all the default recipients that will receive notifications when client uploads files.  
Select "Send notifications to the default recipients only" radio-button if you want only recipients from the list above 
receive the notifications.  
Select "Send notifications to the client representative or the default recipients if the client representative is unknown" 
radio-button in case you want all the notifications are being sent to client representatives. If there is no client 
representative the messages will be sent to default emails listed in "Notify these recipient(s)" field. 
Select "Send notifications to both client representative and default recipients" in case you want the notifications to be 
sent to client representatives and to default emails listed in "Notify these recipient(s)" field. 
When the setup process is finished click "Save" button. 
 
To allow a client to use a portal open his/her profile, select "Client Portal" tab and generate a password for the client. 
From this tab you can also send a password reminder to the client. 
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Client can send a password reminder himself from the portal. Below is an example of "Remind Password" form: 
 

 
 
If entered email and last 4 digits of SSN/EIN are correct the email will be sent to client's mailbox and he/she will see 
the following screen: 
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To login to portal client needs to click "Log In" link and fill in necessary fields. 
 
Below is an example of login page: 
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Upon the login client will be redirected to his/her portal home page where available options are listed. From here client 
can open "Documents" page where documents can be managed or open "Account Info" page to update his/her 
contact information: 
 

 
 
"Account Info" page contains client's information that can be edited by client. To apply changes "Save" button must be 
clicked. 
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... 
 



234 

 

 
 
In the "Documents" section you can find the following sub-sections: 
 
• Published Documents 
• Signed Documents 
• Awaiting Your Signature 
 
"Published Documents" contains all documents published for a client. You can view them by folder or by timestamp. 
Besides of document title, timestamp and size there is signature status available for each document: 
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Client can download any file from the list by double-clicking on it except files that were published for signing. These 
files can be viewed by clicking pencil icon next to their size. To upload a new file the client needs to click "Select file" 
button at the bottom of the page, select a file and click "Upload file" button: 
 

 
 
You can find uploaded files in the client's documents tab or in the "View Document" window in a folder that you've 
setup as "Upload folder". 
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"Signed documents" sub-section contains the list of signed files: 
 

 
 
Files from here can also be downloaded by client by double-clicking on it. 
 
"Awaiting Your Signature" sub-section contains all files that were published for signing. Clients can click pencil image 
to open the document and perform further actions: 
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Find more information about signing process in "Signing documents" chapter. 
 
DocuSign integration 
 
DocuSign integration can be turned on for each TaxWorkFlow user separately: 
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To setup DocuSign integration you need the following information: 
 
• Integrator Key 
• DocuSign User GUID 
• DocuSign User Private Key 
• DocuSign User Template GUID 
 
Below you can find where this information can be found. 
 
First login to your DocuSign account from any browser, click on your profile icon and select "Go to Admin": 
 

 
 
Next select "INTEGRATIONS >> API and Keys" from the sidebar menu. 
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Information under API Username highlighted in yellow is your DocuSign User GUID: 
 

 
 
Next you can add API Integrator Key. Click "Add Integrator Key" button, enter app description, eg. "TaxWorkFlow" and 
click "Add": 
 

 
 
Upon adding a new integrator key "Edit API Integrator Key" window will appear. Here you can find newly created 
Integrator Key. In case you already had an Integrator Key click on it to open "Edit API Integrator Key" window: 
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Click "Add RSA Keypair" button to generate public and private keys. Copy both keys to safe location and paste Private 
Key to TaxWorkFlow "DocuSign User Private Key" field: 
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Next you can add URI by clicking "Add URI" button. In our example URI is 
http://webinar.workflow.rocks/Documents/ProceedSignature but it will be different for your portal so please contact 
TaxWorkFlow support and/or your IT person in case you don't know URI. 
 
The last step is to add DocuSign user template(s) to TaxWorkFlow. To add a template click "Add New Template" 
button. Here you need to name the template, enter a template GUID and decide if the template is default and enabled: 
 

 
 
Template GUID can be found in your DocuSign account at "Templates" section: 
 

http://webinar.workflow.rocks/Documents/ProceedSignature


242 

 

 
 
Click on the template you would like to add to TaxWorkFlow, click information sign near template's name and click 
Copy above the Template's ID: 
 

 
 
 
When your DocuSign account is set you are ready to use it on the portal. Here you can find a Go Live Guide from 
DocuSign: https://developers.docusign.com/esign-rest-api/guides/go-live 
 
 
 
 
Signing documents 
 
As we described above, documents sent for signing can be signed by clients at "Awaiting Your Signature" page of the 
portal by clicking pencil icon next to the document. Upon clicking pencil icon client will be redirected to DocuSign 
portal where he or she can review the document: 
 

https://developers.docusign.com/esign-rest-api/guides/go-live
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While reviewing the document client can leave comments if there are any questions appeared. In case client is ready 
to sign the document he/she can click on the signing area. This will print the signature on the document but it still can 
be cleared by clicking on it and selecting "Clear" option (in case client clicked there accidentally or changed his/her 
mind). Also client can click and change the signature's style or draw the signature manually: 
 

 
 
When the signature is placed client can click "FINISH" button to complete the signing process: 
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After finishing signing process the client will be redirected back to the "Published Documents" page of the portal. 
 
 
 
 
 

15. Help Menu 
 

Below you can find the description of all elements of Help menu. 
 
Help menu looks the following way: 
 

 
 
Below is a description of each element of this menu: 
 
Help Contents - opens a Windows help file. 
About TaxWorkFlow - click this item to discover your build and database version. 
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Release Notes - find out the latest changes in the application. 
TaxWorkFlow Home Page - opens the home page of taxworkflow.com in your default browser. 
Terms And Conditions - shows terms and conditions you've applied installing the application. 
User Guide - opens "TaxWorkFlow User Guide.pdf" document. 
 
 
 
 
 

16. FAQ 
 

Most Frequently Asked Questions 
 
Q: Can I use TaxWorkFlow for other practice management functions besides tax? 
A: Yes, one of the unique features of TaxWorkFlow is that the software can be customized to 
accommodate any sequential accounting process or engagement function. 
 
Q: What are the unique functions/capabilities of TaxWorkFlow? 
A: To learn more about TaxWorkFlow’s robust functionality and unique capabilities please visit our 
Features and Benefits page. 
 
Q: Can I use TaxWorkFlow with any tax software? 
A: Yes, the software can integrate with any tax software. 
 
Q: Does TaxWorkFlow integrate with other software solutions? 
A: Yes, the software can integrate with other software solutions including QuickBooks® and other 
professional grade software. 
 
Q: Will it integrate with any version of QuickBooks, including QB online? 
A: TaxWorkFlow can be integrated with QuickBooks Desktop application now. The QB Online integration is 
not yet available but we're working on the integration now. 
 
Q: How customizable is the system?  
A: One of the most powerful features of TaxWorkFlow is that it can be completely customized to the unique 
needs of each firm. TaxWorkFlow’s unique project-and-task structure includes both pre-defined processes 
and the ability to create completely customized workflows. 
 
Q: What kind of “standard” problems are built into the software? 
A: TaxWorkFlow includes automatically generates problems when certain conditions are met or certain 
requirements fail. There are problems that are pre-defined within the software and there is also the option 
of setting manual problems customized at the individual client level at specified points in the workflow.  
 
Q: Does the software comply with current IRS statutes and regulations? 
A: Yes, TaxWorkFlow is regularly updated to reflect all changes in the IRS tax code. 
 
Q: Is the software compatible and/or supported on Citrix (XenApp)? 
A: Yes, it can run on any Windows physical or virtual machine. 
 
Q: Are uploaded documents actually embedded in the database, or are they separate from the client 
database? 
A: Uploaded documents are embedded (stored as BLOBs – binary large objects). This feature provides 
easy integration with other systems, quick search capabilities inside the application as well as links to tasks 
projects and other features. 
 
Q: Do you have a confidentiality or nondisclosure agreement? 
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A: We normally do not sign the confidentiality or non disclosure because this is the part of our Terms and 
Conditions. You can read them during the installation process or you can find them in the installed 
application at "Help > Terms and conditions". 
 
Q: Are you integrated with ProSeries®? 
A: No, at this time TaxWorkFlow is not integrated with ProSeries®. 
 
Q: How many people can use TaxWorkFlow in my firm? 
A: You can have unlimited users of TaxWorkFlow in your firm. 
 
Q: Which data is stored locally and which data is stored in the TaxWorkFlow cloud? 
A: Only some private user settings are stored locally. Everything else is in the cloud. However,  
TaxWorkFlow does have an option to install everything locally in your database (MS SQL Server or MySQL 
Server). 
 
Q: How are client records secured in the cloud? 
A: TaxWorkFlow uses SSL protocol for connecting to the cloud. Login and password credentials are 
encrypted. 
 
Q: How is client data backed up? 
TaxWorkFlow client data is replicated in real-time to an off-site location to ensure immediate availability of 
the data from a secondary location in case of a catastrophic event at the primary data storage location.  
 
Q: Where is the cloud located? 
A: The cloud is located in our own cabinet on our own servers in New Jersey in Equinix NY4 datacenter. 
Only our staff has access to this cabinet. Learn more about this data center at 
http://www.equinix.com/locations/united-states-colocation/new-york-data-centers. 
 
Q: Do you store any data at datacenters in foreign countries? 
A: No. TaxWorkFlow, LLC is based in New York City and all data is stored securely in New York. 
 
Q: Can I move my database from the cloud to in-house servers? 
A: Yes, we can help you to do this anytime. 
 
Q: Do I need to store a full EIN/SSN of my clients in the system? 
A: No, you can enter just the last four digits of client’s EIN/SSN in the database. 
 
Q: Do you have some price lock terms? 
A: Yes, price lock terms are written in the invoice when you buy the service. 
 
Q: Can I pay on any type of payment plan, or is it only upfront? 
A: We have annual payments for the year in advance. However we offer you a free period of 2-3 weeks for 
free set up with our team. This will help you learn if the product works for you. 
 
Q: Client Portal:  Is it through you or do we have to maintain a separate portal? 
A: The client portal is through us. We can offer email and web site hosting as well (free as part of the 
service). 
 
Hardware Questions 
 
Q: Is TaxWorkFlow a cloud-based or a server-based solution? 
A: TaxWorkFlow is a unique hybrid software application that combines the processing speed of a PC 
desktop platform with the enhanced data storage capacity of a cloud-based solution. 
 
Q: How is client data secured and backed up? Where is data stored? 
A: The client data is replicated in real-time to an off-site location to ensure immediate availability of the data 
from a secondary location in case of a catastrophic event at the primary location. Client data is stored on 
TaxWorkFlow’s own dedicated servers in our own rack space in the Equinix NY4 data center.  

http://www.equinix.com/locations/united-states-colocation/new-york-data-centers/
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Q: How can I integrate and/or migrate data in and out of the system to other platforms? 
A: TaxWorkFlow allows you to import customer information from your existing tax system using an Excel 
spreadsheet. It also allows you to batch-import the documents from a file system with automatic 
categorization. 
 
Q: Does the software have to be installed on each PC where it is used? 
A: Yes, because the system is a hybrid desktop/cloud solution, each user must install the program on their 
workstation. 
 
Q: My computer is quite old, will the application run on it? 
A: Yes. TaxWorkFlow is a native Windows application so it will run optimally even on older computer with 
older versions of the Windows operating system (i.e. Windows XP etc.).  
 
Q: What are the minimum operating system requirements for the software? 
A: To use TaxWorkFlow you need the following: 
Windows XP, Vista, Ultra, 7, 2008, both 32 and 64 bit  2 GB RAM  10 GB hard disk space and a  high-
speed internet connection (at least 1Mbps upload, 5Mbps download speeds). 
 
Q: Can TaxWorkFlow be used on a Macintosh computer or a mobile device? 
A: No. Windows is the only operating system supported for TaxWorkFlow at this time. 
 
Q: What type of internet speed should I have? 
A: You can use any internet connection, but a high-speed internet connection will save you time, reducing 
how long it takes you to upload or download documents, for example. 
 
Q: Can the application be run on tablets? 
A: Yes, but only on Windows tablets. 
 
 
 
Service Questions 
 
Q: What types of support and training services are included?  
A: Your TaxWorkFlow license includes telephone and email support, in addition to a downloadable User 
Guide to help you learn and maximize TaxWorkFlow’s benefits. 
 
Q: What is a time frame to get the application completely set up to use?  
A: Normally it takes two or three 30- to 60-minute calls to set up TaxWorkFlow for you to use in your firm. 
 
Q: How long can I expect to wait for support when I have a request or an issue? 
A: We generally aim to address all client requests and issues within 24 to 48 hours. 
 
Q: What is the price structure of TaxWorkFlow? Is it per seat, per user or per firm? 
A: TaxWorkFlow annual pricing is $1,500 on a per-firm basis and is subject to sales tax in New York and 
New Jersey. 
 
Q: What is the cost for subsequent subscription years of TaxWorkFlow? 
A: Currently, clients receive a permanent lock guarantee on the $1500 price for TaxWorkFlow. The annual 
fee will remain the same as long as you remain our client. 
 
Q: What is the licensing if we want multiple instances of TaxWorkFlow? We might have a desire to 
have a separate instance of the program for each of our clients? 
A: Each license is per database connection. So if you want to have multiple database connections, you will 
have to purchase additional license for each connection. 
 
Q: What extra-charges should I pay buying the application? 
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A: There’re no extra-charges at all. Buying TaxWorkFlow with the application you’re getting a Support, 
unlimited storage place in the cloud, unlimited users, offices, returns etc. It’s all free of charge when you 
buy an application. Also we offer free the client portal, web and email hosting for existing customers - in 
case you want to further consolidate your bill. 
 
Q: How long is a trial period of using TaxWorkFlow? 
A: The trial period is flexible. We normally offer two weeks trial period but we can extend it to one month if 
there’s a reasonable delay. 
 
Q: How does trial period work?  What are the payment arrangements? 
A: The trial period is really the period during which we are implementing the software and training your 
staff. This is done via the webinars where we interview you and understand your requirements, and at the 
same time we customize the system for you. So you don't have to learn the system to initially setup and 
start using it. You do not have to pay anything until you confirm that the system we provided and 
customized meets your needs. 
 
Q: Can I cancel my subscription? 
A: If you cancel your subscription, TaxWorkFlow will permanently delete your account along with all the 
data from the cloud. Before the account is deleted, you may wish to export all of your clients and 
documents to preserve your data. We will be happy to assist you in transferring your data to another 
system. 
 
Q: Do you have an agreement that defines the rights and obligations of each party? 
A: We don't have an individual agreement. We have standard terms & conditions, that you accept by 
signing up (that's the industry standard for the subscription-based services). 
 
Functionality Questions 
 
Workflow 
 
Q: I accidently completed the task, how do I reverse it?  
A: If the task belongs to a closed project, it can't be reversed. If the task belongs to an open project, you 
can downgrade the project. Simply open the project that the task belongs to and click the “Downgrade” 
button. 
 
If the task is custom (not part of a project), it can be reopened by opening this task again (please note, it 
will be in a group of closed tasks) and click the “Reopen task” button. 
 
Q: Can I assign one task to two people? 
A: While you cannot assign a task to two people, you can create a “special user” and get your staff to 
complete the projects and tasks assigned to this user. The special user must be active to allow other users 
to complete its assigned projects and tasks. 
 
Q: Is there a way to select multiple clients do projects at one time? 
A: Yes. Please read the "Select user form" topic to familiarize with this feature. 
 
Q: Can I delete a task from the project? 
A: If the project is already created, you can only fail the task or complete the task you want to exclude from 
a certain project. If you need to delete a task from the project permanently and it isn’t  in the projects you 
will open in the future, you must go to “Edit project templates.” From here, select the project you want to 
modify, click “Modify project template workflow” and delete the task you don't need in this project. 
 
Q: Is it possible to change ownership of a task? 
A: Yes. You can reassign the task to another user of the system if you have the appropriate permission. 
Select a task in the grid of the Dashboard or at the “View tasks” window and click the “Reassign Task” 
button. You can also reassign the task when it is open in a separate window. 
 
Q: How can I see the status of tax returns with approaching expiration date? 

http://thetaxworkflow.com/articles/License%20Agreement.pdf
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A: In TaxWorkFlow, the expiration date is referred to as a deadline. Every time you create a task or a 
project you can assign a deadline to them. You can sort projects or tasks by their deadline in the grid and 
find the information you need. 
 
Q: How do I make sure that specific steps of the project are going to the correct employee? 
A: To make sure a step is going to the appropriate person, you need to create a rule for the corresponding 
task in the project. To do this, go to “Administration > project templates”, in the window that appears and 
select the project that contains the task that you want to assign to a particular person. Double-click on this 
task to edit it and select the user that you would like this task to be assigned to each time it is created in 
future. 
 
Q: How do users get notified that a new task or project is assigned to them? 
A: TaxWorkFlow’s built-in email system will send a notification to a user immediately after a task is 
assigned to them. It is important to make sure that each user’s account is set up correctly to receive these 
notifications. The users’ account must have a valid email address and the “Subscribe this user to automatic 
projects and tasks email notifications” checkbox must be checked. 
 
Q: I have a monthly recurring project – and set the first project to start. I automatically set up 
projects for a few more months. The manually created project set up the tasks correctly, but the 
others all have a custom task showing up. What is it for? 
A: That's the extra task for automatically created projects - a reminder to double-check the workflow. It 
does not happen for manual project creation because you customize the project when creating it already. 
You can just simply complete it. 
 
Q: When the projects recur each week/month, how do we get the staff member that is in charge of 
that client to show as the responsible person on that project? 
A: We can make it to re-use the previous project's workflow; so the default template will not be used for this 
client moving forward. 
 
Q: Is there a way to choose whether or not to have some of the criteria recur with the project, rather 
than defaulting to the template? (i.e. notes, staff, tasks, if we need an extra task included for a 
specific client). 
A: Yes we can make certain changes to that. When you start setting up the workflow, and run into an issue 
when you need some extra rule/note etc. reoccurring, we can accommodate that request for you. 
 
Q: Can tasks reoccur? 
A: No, only projects can reoccur. But the project can consist of just one task that is created automatically, 
and when you close this task, the project will be closed as well. 
 
Q: Is there any option to print reports? 
A: Yes, you can export any table to Excel. For example, you can use filters to build a certain client list or 
task list and then export it to Excel. 
 
Q: How much master accounts can be set up for one secondary account? 
A: Only one master account is possible. 
 
Q:  In the project instruction portion, why doesn’t it change when a task is completed and show 
where the project is at? 
A: project instruction is created to describe the work for the whole project though it can sound the same as 
some task from the project. 
 
Q:  Is there a way to have a column that lists who is working on the task without have to open the 
project and open the task? Can this be a column on the main project page? 
A: No, there's no such column. 
 
Q: When a problem is made she would like to know is there any way that she can see this on the 
main project page without having to open the task to see the problem? 
A: Right now you can't see project's problems from the main project page. 
 



250 

 

Q: Can Inactive Users still access TaxWorkFlow? 
A: Inactive users can't access the TaxWorkFlow. However, they will show up in the user lists inside the 
TaxWorkFlow (until you reassign tasks/projects away from them). Then you can hide them to remove from 
the lists. 
 
 
 
Document Management 
 
Q: Is there a way to attach documents to a project in TaxWorkFlow? 
A: Yes, you can place documents right into the project/task instructions using TaxWorkFlow’s drag-n-drop 
interface or you can use the “Add File” button and select documents to attach from your computer or other 
accessible locations using the “Import documents from folder” dialog. 
 
Q: Can I assign a document folder to one client? 
A: TaxWorkFlow’s client folder structure is global for all clients. However, you can file certain folders in 
client-specific subfolders by typing the subfolder name in the bottom of the "Select Folder" form. 
 
Q: Should I create a document folder tree every time I add a new user? 
A: The document folder tree is global for all users, clients and offices, so you need to create it only once for 
all users. In addition, you can customize the tree and add subfolders for specific documents. Subfolders are 
not global and will be shown only to the client for whom they were created. 
 
Q: Do files stay in their native format in TaxWorkFlow? 
A: Yes. 
 
Q: When I scan a document into the system, will your software be OCR so that the documents can 
be searchable. 
A: No, our software does not OCR documents and does not provide the search inside the document. 
 
Q: How can stored documents be exported out of TaxWorkFlow?  
A: Stored documents can be exported into a folder by recreating the folders tree of the database. Or, you 
can export just one branch of the folders tree. 
 
 
 
Email Module 
 
Q: How can I set up my email? 
A: Select the “File>Edit Connections” menu item. In the window that appears, open the “Outgoing Email” 
tab. Here you can enter your email settings and test them to ensure your email is working properly. You 
can find detailed instructions in TaxWorkFlow or in the online help content. 
 
Q: I have found that when I assign the project to one of my employees, it sends an email out to all of 
my employees. I want to send an email to only the employee that is handling the associated 
account. Is this possible? 
A: Unfortunately, you cannot select which notifications you would like to receive in TaxWorkFlow. There are 
currently two options: receive all notifications or receive no notifications. There are future plans to enhance 
this functionality. 
 
Q: Can TaxWorkFlow’s email module integrate with Gmail? 
A: Yes, the TaxWorkFlow email module can integrate with Gmail, Hotmail and other email services. It can 
also integrate with Microsoft Exchange. 
 
Q: Is there any type of instant messaging in the application? 
A: No. TaxWorkFlow does not currently have instant messaging functionality. 
 
Q: Can I import previous emails into the application? 
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A: Yes. All emails are stored in the Document Management System so you can easily import any 
documents including emails to the system using an “Import documents from folder” option. 
 
Q: Can a built-in email system be synchronized with a Google account? 
A: Yes. 
 
Q: How often does email sync?  Can it be set to sync when you tell it to? Or is it a specific time of 
day? 
A: By default it syncs continuously. 
 
Q: My email service blocks TaxWorkFlow when it tries to sync the email. How can I resolve this 
issue? 
A: Open your mailbox in browser. Here you can find a new message about blocking the application or 
some pop-up alerts. Follow the instructions to grant TaxWorkFlow an access to your email account. You 
can find an example how to do it for your Gmail account here. 
 
Q: How can I setup email templates? Where can I find a list of macros I can use in my email 
templates? 
A: Please use appendix A of this guide to get a full information about macros, how and where they can be 
used. Examples of templates with macros are also available in appendix A. 
 
Q: How to turn off email problem prompt? I don't want en email template opens upon problem 
creation. 
A: To turn off email problem prompt you can change problem's scope from Client-related to Staff-related. 
To perform these changes you can open "Administration">"View problem templates" and change each 
template manually: 

 
 
Q: Email messages sent from Office 365 account to AOL or Verizon emails are bounced with the 
following error message: Remote Server returned '521 5.2.1 : AOL will not accept delivery of this 
message.' 
A: Please use this article to setup your Office 365 email: https://support.office.com/en-us/article/How-to-set-
up-a-multifunction-device-or-application-to-send-email-using-Office-365-69f58e99-c550-4274-ad18-
c805d654b4c4  
 
 
 
Client Relationship Management (CRM) System 
 
Q: Can I import clients from QuickBooks®? 
A: Yes, you can import clients from QuickBooks® using a built-in wizard. 
 

https://support.office.com/en-us/article/How-to-set-up-a-multifunction-device-or-application-to-send-email-using-Office-365-69f58e99-c550-4274-ad18-c805d654b4c4
https://support.office.com/en-us/article/How-to-set-up-a-multifunction-device-or-application-to-send-email-using-Office-365-69f58e99-c550-4274-ad18-c805d654b4c4
https://support.office.com/en-us/article/How-to-set-up-a-multifunction-device-or-application-to-send-email-using-Office-365-69f58e99-c550-4274-ad18-c805d654b4c4
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Q: How can I transfer all of my clients’ data from another system to TaxWorkFlow? 
A: You can export the data to an Excel® spreadsheet and then import it into TaxWorkFlow using the “Import 
clients from Excel” feature. 
 
Q: What happens when a client has moved, has a new phone number or some other client 
information has changed? 
A: You can advise clients to log into the Client Portal and update their information. You can also 
synchronize data with QuickBooks® or Lacerte® if you use these platforms. Alternatively, you can export 
new data from where it resides and import it into TaxWorkFlow. The CRM reconciliation tool will help you 
avoid duplicate client records when you import client data to TaxWorkFlow.  
 
Q: How can I make client-related notes? 
A: You can add notes for a particular client in the “Edit Client” form. In this view, all notes added to the 
client’s tasks and projects will also be visible. 
 
Q: Is there a calendar/schedule function? 
A: Yes, the calendar function is available when you have Microsoft Exchange® server integration and the 
client portal module. This calendar features dual synchronization with your Outlook™ calendar (so you can 
book a meeting in either TaxWorkFlow or Outlook and the calendar slot will be marked as “Busy”). 
 
Q:  Is there a setting to remove a discontinued client from the system without deleting the client 
altogether? 
A: By default, you can un-delete the client after you delete him/her. It's not a permanent wipe-out and you 
can have it back later. 
 
Q:  Can we add two businesses to the client? We have a few clients that own multiple companies, 
how do we or can we do this? 
A: Unfortunately you can't assign numerous companies to one client. You need to create separate account 
for each company of the client. 
 
 
 
 
Integration with 3rd party products 
 
Q: Can TaxWorkFlow’s email module integrate with Gmail? 
A: Yes, the TaxWorkFlow email module can integrate with Gmail, Hotmail and other email services. It can 
also integrate with Microsoft Exchange. 
 
Q: Is there a calendar/schedule integration? 
A: Yes, the calendar function is available when you have Microsoft Exchange® server integration and the 
client portal module. This calendar features dual synchronization with your Outlook™ calendar (so you can 
book a meeting in either TaxWorkFlow or Outlook and the calendar slot will be marked as “Busy”). 
 
Q: How can I integrate and/or migrate data in and out of the system to other platforms? 
A: TaxWorkFlow allows you to import customer information from your existing tax system using an Excel 
spreadsheet. It also allows you to batch-import the documents from a file system with automatic 
categorization. 
 
Q: Does TaxWorkFlow integrate with QuickBooks? 
A: TaxWorkFlow integrates with QuickBooks Desktop. Please see Interaction with QuickBooks chapter of 
this guide. 
 
Q: Can QuickBooks accounts be synced with TaxWorkFlow? 
A: No, it's impossible at the moment. 
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17. Appendix A. Email macros and their usage examples 
 

Below is the list of macros you can use in the email templates: 
 

Client related macros Macros definition System templates  
where macros  
can be used 

Can be used 
in user's 

templates 

#FIRST_NAME# Client's first name All system templates Yes 

#CLIENT_FIRST_NAME# Client's first name All system templates Yes 

#LAST_NAME# Client's last name All system templates Yes 

#CLIENT_LAST_NAME# Client's last name All system templates Yes 

#CLIENT_NAME# Full client's name, includes name 
and surname 

All system templates Yes 

#CLIENT_EMAIL# Client's email address All system templates Yes 

#COMPANY_NAME# Company name All system templates Yes 

#CLIENT_COMPANY_NAME# Company name All system templates Yes 

#CLIENT_ADDRESS# Full client's address including city, 
state and zip. Country is included if 
it's not US 

All system templates Yes 

#CLIENT_FULL_NAME# Includes TaxPayer First  Name, 
TaxPayer Last Name, Position, 
Company Name, Spouse First 
Name, Spouse Last Name 

All system templates Yes 

#CLIENT_PORTAL_URL# Client's portal web address All system templates Yes 

#CLIENT_SALUTATION# Full client's name including prefix, 
name, surname and suffix 

All system templates Yes 

    
User related macros Macros definition System templates  

where macros  
can be used 

Can be used 
in user's 

templates 

#USER_FIRST_NAME# User's first name All system templates Yes 

#USER_LAST_NAME# User's last name All system templates Yes 

#USER_FIRST_LAST_NAME# Full user's name, includes name 
and surname 

All system templates Yes 

#USER_NAME# Full user's name, includes name 
and surname 

All system templates Yes 

#USER_FULL_NAME# Full user's name, includes name 
and surname 

All system templates Yes 
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#USER_TITLE# User's title All system templates Yes 

#USER_NAME_AND_TITLE_WITH_COMMA# Full user's name, includes name, 
surname and title separated by 
comma 

All system templates Yes 

#USER_EMAIL# User's email All system templates Yes 

#USER_CELL_PHONE# User's cell phone number All system templates Yes 

#USER_CELL_PHONE_WITH_PREFIX# User's cell phone number   with 
prefix, eg. Cell: 123-456-7890 

All system templates Yes 

#USER_CELL_PHONE_WITH_SUFFIX# User's cell phone number   with 
suffix, eg. 123-456-7890 (cell) 

All system templates Yes 

#USER_HOME_PHONE# User's home phone number All system templates Yes 

#USER_HOME_PHONE_WITH_PREFIX# User's home phone number with 
prefix, eg. Home: 123-456-7890 

All system templates Yes 

#USER_HOME_PHONE_WITH_SUFFIX# User's home phone number with 
suffix, eg. 123-456-7890 (home) 

All system templates Yes 

#USER_WORK_PHONE# User's work phone number All system templates Yes 

#USER_WORK_PHONE_WITH_PREFIX# User's work phone number with 
prefix, eg. Work: 123-456-7890 

All system templates Yes 

#USER_WORK_PHONE_WITH_SUFFIX# User's work phone number with 
suffix, eg. 123-456-7890 (work) 

All system templates Yes 

#USER_OTHER_PHONE# User's other phone number All system templates Yes 

#USER_OTHER_PHONE_WITH_PREFIX# User's other phone number with 
prefix, eg. Other: 123-456-7890 

All system templates Yes 

#USER_OTHER_PHONE_WITH_SUFFIX# User's other phone number with 
suffix, eg. 123-456-7890 (other) 

All system templates Yes 

#USER_FAX# User's fax number All system templates Yes 

#USER_FAX_WITH_PREFIX# User's fax number with prefix, eg. 
Fax: 123-456-7890 

All system templates Yes 

#USER_FAX_WITH_SUFFIX# User's fax number with suffix, eg. 
123-456-7890 (fax) 

All system templates Yes 

    
Document related macros Macros definition System templates  

where macros  
can be used 

Can be used 
in user's 

templates 

#DOCUMENT_TITLE# Title of the document  DocumentPublicationEmailTemplate No 

#DOCUMENT_FILENAME# Name of the file DocumentPublicationEmailTemplate No 
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#DOCUMENT_TIMESTAMP# Timestamp of the document in  
"YYYY-MM-DD hh:mm:ss" format 

DocumentPublicationEmailTemplate No 

#DOCUMENT_SIZE# Size of the document DocumentPublicationEmailTemplate No 

#DOCUMENT_CATEGORY# Category of the document  DocumentPublicationEmailTemplate No 

#DOCUMENT_SUBCATEGORY# Subcategory of the document DocumentPublicationEmailTemplate No 

#DOCUMENT_FOLDER# Name of the folder where document 
is placed 

DocumentPublicationEmailTemplate No 

#DOCUMENT_SUBFOLDER# Name of the subfolder where 
document is placed 

DocumentPublicationEmailTemplate No 

    
Workflow related macros Macros definition System templates  

where macros  
can be used 

Can be used 
in user's 

templates 

#INVITATION_LINK# Secure link that allows user to join 
TaxWorkFlow 

AccountActivationInstructions No 

#INVITATION_STRING# Secure string that allows user  to 
join TaxWorkFlow 

AccountActivationInstructions No 

#WEB_PASSWORD# User's password PasswordReminderEmailTemplate No 

#SYSTEM_MESSAGE# Message about task/project 
completion and other user's actions 

SystemMessageEmailTemplate No 

#EXCEPTIONS# List of problems related to specific 
client 

ProblemEmailTemplate No 

#PROJECT_NAME# The name of the project in a project 
template 

ProjectCreationEmailTemplate No 

#PROJECT_DUEBY# Project's deadline ProjectCreationEmailTemplate No 

#PROJECT_YEAR# Project year ProjectCreationEmailTemplate No 

#PROJECT_QUARTER# Project quarter ProjectCreationEmailTemplate No 

#PROJECT_MONTH# Project month ProjectCreationEmailTemplate No 

#PROJECT_WEEK# Project week ProjectCreationEmailTemplate No 

#PROJECT_PERIOD# Project period ProjectCreationEmailTemplate No 

#TASK_NAME# Task template name ProjectTaskCompletionEmailTemplate No 

#TASK_DUEBY# Task deadline ProjectTaskCompletionEmailTemplate No 
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System related macros Macros definition System templates  
where macros  
can be used 

Can be used 
in user's 

templates 

#MACHINE_NAME# Name of user's machine All system templates Yes 

#EMAIL_SERVER_ADDRESS# Address of the outgoing email 
server 

All system templates Yes 

#APPLICATION_NAME# Name of the application All system templates Yes 

#APPLICATION_VERSION# Version of the application All system templates Yes 

 
 
 
Below are template examples that show how you can use macros to speed up your work with correspondence: 
 
"Cell phone number changed" email campaign: 
 

TEMPLATE MESSAGE 
Dear #CLIENT_FIRST_NAME#, 
 
This is to inform you that my cell phone number has been 
changed to #USER_CELL_PHONE# 
Please update your contact book and refer all the further 
communications by this number. 

#USER_FULL_NAME# 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 

General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 

Dear John, 
 
This is to inform you that my cell phone number has been 
changed to +12345678900 
Please update your contact book and refer all the further 
communications by this number. 

Michael Jones 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 

General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 

 
 
 
"Client's details update request" email campaign: 
 

TEMPLATE MESSAGE 
Dear #CLIENT_NAME#, 
 
Due to the oncoming tax season please review your 
details on the portal at #CLIENT_PORTAL_URL# and 
update it if necessary. Thank you! 

#USER_FULL_NAME# 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 

Dear John Smith, 
 
Due to the oncoming tax season please review your 
details on the portal at http://portal_address and update it 
if necessary. Thank you! 

Michael Jones 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 
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General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 

General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 

 
 
 
"Holiday greetings" email campaign: 
 

TEMPLATE MESSAGE 
Dear #CLIENT_FIRST_NAME#, 
 
We wish you a very Happy Holiday season and a peaceful 
and prosperous New Year. We're so glad to have you as a 
client and look forward to serving you in the future. 
 
TaxWorkFlow Team 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 

General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 

Dear John, 
 
We wish you a very Happy Holiday season and a peaceful 
and prosperous New Year. We're so glad to have you as a 
client and look forward to serving you in the future. 
 
TaxWorkFlow Team 

 

 
TaxWorkFlow, LLC 
517 Grand Street, Fl 1 
New York, NY 10002 

General Inquiries: info@thetaxworkflow.com 
Sales and Technical Support: 
support@thetaxworkflow.com or call +1 
646.461.2197 
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18. Appendix B. Invoice macros 
 

Below is the list of macros you can use in the invoice templates: 
 
#ISSUING_COMPANY_NAME# Name of the office that is issuing the invoice 
#ISSUING_COMPANY_ADDRESS# Address of the office that is issuing the office 
  
#PAYEE_TAXPAYER_NAME# Client's full name 
#PAYEE_ADDRESS# Client's address 
  
#INVOICE_STATUS# Status of the invoice, eg. "INVOICE" or "DRAFT INVOICE" 
#INVOICE_DATE# Date invoice was issued 
#INVOICE_NUMBER# Invoice number 
#INVOICE_FOR# Reason the invoice was issued (eg. Services Provided) 
#INVOICE_TOTAL# Total invoice amount 
#INVOICE_CREDITS# Credits applied to the invoice 
#INVOICE_BALANCE_DUE# Balance due of the invoice 
#INVOICE_COMMENTS# Invoice comments. "Memo" field of the invoice will be displayed there 
  
#INVOICE_ITEM_ACCOUNT# Name of the invoice item account 
#INVOICE_ITEM_BILLING_DESCRIPTION# Billing description of the invoice item 
#INVOICE_ITEM_PERIOD# Selected period of the invoice item 
#INVOICE_ITEM_SERVICED_DATE# Serviced date of the invoice item 
#INVOICE_ITEM_QTY# Quantity of the invoice item 
#INVOICE_ITEM_PRICE# Price of the invoice item 
#INVOICE_ITEM_AMOUNT# Invoice item amount 
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